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1 Getting Started

1.1 What is MindCAD?

MindCAD is a suite of specialist programs that have been developed specifically for shoe design and
manufacturing.

Last Design & Engineering - For input, modification and flattening of lasts.

3D Design & Engineering - Allows lines to be drawn on a last in 3D and 2D. These lines can then
be used to create parts with thickness, and textures. Accessories, punches, holes and padding can
also be added, as well as laces and soles.

The final design can be output to:

2D Design & Engineering - For 2D part creation, grading, cutting and specification

Viewer - This is a free package of visualization software from Mind and can be downloaded from
Mind Technology website.

1.2 Before you begin

IMPORTANTE NOTE: A valid product authorization file must be installed before MindCAD can be
used.

If you’d like some sample data to use in MindCAD 3D Design & Engineering:
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1. From the File menu, select Open to load example projects.
2. Select a file and press “Open” (or double click the file).

All instructions in this manual are correct at the time of printing. Some sections may not be up to
date due to subsequent updates to MindCAD 3D Design & Engineering.

1.3 How do I start MindCAD 3D Design & Engineering?

Double click MindCAD 3D Design & Engineering´s icon  on your desktop. MindCAD 3D
Design & Engineering will start shortly after.

1.4 How do I use Menus?

Almost everything in MindCAD 3D Design & Engineering can be accessed through the main
menu. This is shown in the picture above and is displayed at the top of the MindCAD 3D Design &
Engineering screen.

1. Select an item from the main menu. A drop down list is displayed, showing a list of sub-items,
each corresponding to specific program action.Greyed out sub-items mean that a specific program
action is not available (e.g. a paste action will not be available is no copy action was previously
executed).
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2. If you move your mouse to an item that has an arrow alongside, as highlighted above, an
additional list of sub-items will appear.
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3. If the item is followed by just … (for example, Texture… above), selecting the item will display a
dialog box so that you can enter data and make selections.
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1.5 MindCAD 3D Design & Engineering Layout

The image below shows MindCAD 3D Design & Engineering's interface.

1. Menu Bar - Most of MindCAD 3D Design & Engineering’s functionality may be accessed

through this menu.

2. Main Bar - This toolbar allows a user to open a new project or an existing one, save a project,

print, cut, copy, paste, undo, redo, zoom to fit, go to help topics and open Mind's web site.

3. Constrain Bar - This toolbar allows a user to control on which side of the last drawing operations

are enabled on (medial or lateral), enable or disable side crossing lines, and color code lines

according to their position (medial or lateral). This toolbar also allows a user to control 'snap'

editing to the nearest line, nearest intersection, nearest end or nearest point. 

4. View Settings - This toolbar allows a user to control the project's visualization settings and save

them.

5. General 3D Bar -This toolbar allows a user to invoke the interactive texture mapping tool, copy

properties, show/hide selected objects and disable/enable automatic rebuilding of 3D objects.

6. Offsets Bar - This toolbar allows a user to change the lifters and thickness values.

7. Tabs -  Allows a user to switch between sets of projects, as well as close any of them.

8. Tools Bar - This toolbar allows a user to select the draw lines tool, turn on/off the links, create
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offsets, mirror selected lines and split lines.

9. Layers Bar - This toolbar allows a user to turn on/off project layers.

10.Parts Bar - This toolbar allows a user to create parts, holes, punches, padding's and stitches.

11.Variants and Options - This toolbar allows a user to store the current project in different colour,

material sole and accessory combinations.

12.Object Browser Bar - This toolbar shows the elements' hierarchy. Through this toolbar it's

possible to show/hide elements. 

13.Views Bar - This toolbar allows a user to change the last's point of view.

14.Libraries - This toolbar contains accessories, stitches, punches and materials options.

15.Canvas Area - Allows a user to visualize the last and all created objects.
16.Status Bar - This toolbar located at the bottom of the document window provides additional

information about the project a user is creating.

1.6 How do I manipulate the view contents?

There are three main interaction classes for direct manipulation of the 3D environment:

Scaling

Moving (Panning)

Rotating

1.6.1 Scaling

To scale the view, in both 3D and 2D windows,

1. Press the Ctrl key and hold down the middle mouse button. View contents will scale up/down as
the mouse is moved up/down.

2. Releasing the middle mouse button will end the scaling process.

1.6.2 Moving (Panning)

To move the view contents, in both 3D and 2D windows,

1. Press the Shift key and hold down the middle mouse button. As the cursor is moved, view
contents will move with it.

2. Releasing the middle button will end the process.
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1.6.3 Rotating

To rotate view contents, in the 3D window,

1. Hold down the middle mouse button. As the cursor is moved, view contents will rotate.

2. Releasing the middle button will end the process.

1.7 Getting Help with MindCAD 3D Design & Engineering

Help in  MindCAD 3D Design & Engineering is available in the following ways:

Tool Tips

Status Bar Help

Standard on-line Help

1.7.1 Tool Tips

Placing the cursor over a button will display a brief description of the function of that button.

1.7.2 Status Bar Help

Placing the cursor over a button will display information about that button in the status bar.

1.7.3 Standard on-line Help

1. Select Help from the MindCAD 3D Design & Enigneering's menu.

2. Select Contents and Index and then the item you require. There's a separate section for
each option on the main toolbar.

1.8 Whats New

1.8.1 2012.V1

MindCAD 3D Design & Engineering® software offers the following new features and benefits:

Interoperability

New paradigm for storage/ New storage infrastructure
In MindCAD 2012 version, the storage infrastructure is not file system oriented by default. To
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retain old functionality and 2011.V1 processes, every application have the ability to Open standalone
file formats. Drag and drop functionality of those files is retained.

A “standalone PDM (Product Data management) server” is now supporting the new storage
model.

User Interface Enhancements

New user interface 
MindCAD 2012 version has a brand new user interface: more dynamic look and feel, new

icons, new interface skins and customization features.

Revised menu structure
The menu structure has been reorganized to improve navigation and ease of use.

Usability and Productivity

Revised Library Panes
There are available new and flexible library panes, allowing advanced customization. 
Support for multiple sources - including libraries residing in external PDM servers (this

component is licensed separately)

Key accelerator assignment
The new infrastructure allows advanced interface customization.

Design Accelerators

Applying Punches at multiple parts
It´s now possible to select multiple parts at once, and apply the one punch distribution to all

of them.

Color/Material assignment accelerator
New “color & texture” properties panel with quick assignment of the most recently used

colors and textures.

Auto Liner/ Auto Bootie
With auto liner or auto bootie it’s now possible to create a part by just selecting its top line.

With this option, when the top line is selected, the rest of the part will be constructed 
automatically from the selected line to the last bottom line.

Auto liner will create an intern part and auto bootie will create an outside part.

Delayed/ User controlled reconstruction of parts
It’s now possible to deactivate the automatic part reconstruction.
When this option is active, it’s possible to change the base lines of the part; change lifters

and the part will not reconstruct until we deactivate the option. Then all the changes will be applied 
to the part.

Auto Padding Full part
Now it’s possible to automatically apply padding to a full part.
Instead of selecting all the lines of the part, you can just do a right click on the part and

select the option Finish Padding (Full Part)

Reconstruction of automatic laces
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Now you can, just after creating laces by template, move the punches position and
automatically the laces will be rearranged.

Creating parts: several picks over the same line now works properly [Fix]
When creating parts, once one line is selected you can do several picks over it – now

without anomalies of the picking algorithm that could imply to cancel the current selection and start
all over again.

Bezier support
It is now possible to import/export Bezier(AI curves) natively in 3D. The interface for creating

those lines inside 3D is exactly the same as AI, for the designers comfort.
Now, you don’t need two different tools to move handles and tangents; just pick a handle

and it will turn sensitive to tangent manipulation. Use SHIFT to ensure equal tangents.

Quality control for each part
Now the quality factor option is a “Part property”, instead of a “Deform property” as before. 

Real-time Part Assessment
For real-time part assessment, under the View menu, go to Panel tabs and select Part

assessment.

Zoom to fit to selected elements
Now you can select the desired elements and click Zoom to fit.

Interoperability

Revised free space manipulator to “3D Stencils” and generic imported 3D geometry.
The align tool is now the same to both 3D stencils and imported 3D geometry.  

Usability and Productivity

Cut tool sensitive to snapping
Now you can select the required constrain, and the split line tool will snap to the nearest

line, end, point or intersection.

Revised curve tool
Previously, you had several tools - “closed line/curve/polyline/polygon” and sketch tools - to

draw lines and you needed to select the tool line according to what you wanted to draw.
Now all those tools were merged into just one. The tool will respond to the movements you

make, i.e.:  if you start a line by clicking and dragging,  you will draw a sketch line; if you 
approximate the line end to its beginning, the line will join and became a closed line.

New Layers Bar
You have now new Layers by Object Type, Generic Layers and Search Browser.

1.8.2 2013.V1

MindCAD 3D Design & Engineering® software offers the following new features and benefits:

User Interface Enhancements
Revised icons dimensions

By default, the icons are now smaller.
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Windows resize 
You can now resize the Export and Open File panels, thus improving the interaction with the

file system.
Change line type

You have now change the line type, using the new available options.
Single Material tab

You now have only one Material tab, where you can select which material you want, and
select the zone of the part – outside, inside, edges - to work with.

You have also a select an applied material and copy and paste it to the selected part zone.
Stencils grouping

With this new option, you can view at once more than a stencil.
This grouping allows you to control simultaneously all the stencils included within the same

group (set the transparency level, e.g.).
Enhanced search filter

In addition to the generic search, the Layers and Objects tabs have now specific search
filters on layers and objects.

Pipes Design Accelerators
Multiple sections and transitions

You can create simple pipes as a revolution element, based on and following a master line.
You can also define the number of its sections and the spacing between those sections – thus
creating a transaction zone between pipe sections.

You can now select each of the sections and transitions - or multi-select them - and edit its
properties.

Adaptive transitions
If you change the pipe sections, transitions will adapt automatically to these changes,

ensuring the interconnection consistency.
Memorizing properties

To simplify the simple pipes creation, the properties set for the last pipe you create are
saved and used when creating the next pipes.

Laces Design Accelerators
Multiple sections and transitions

Laces are now structurally identical to pipes, presenting the same features and editing
capabilities of pipes (as above described).

Increase the lace size, prolonging its master line.

Upper Flattening
A new upper flattening representation is now available, simplifying the importing process of complete
shells.

Padders and Lifters Design Accelerators
Edge sharpness on padders and lifters 

You have now better control over padders and lifters edges, by setting different values for Top
and Bottom edge sharpness. 

Edges Design Accelerators
New edge types 

Two new edge types available: Chanfer Down and Chanfer Up.
New edge preferences

Using the new options in the Preferences menu, you can setup a preferred Edge Material,
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Edge Geometry and Edge-offset/ Part-thickness Relation.
Sync edge boundary offset and part thickness

To maintain the edge proportions, you can now synchronize the edge boundary offset with
the thickness of the part – if you change the thickness, the boundary will follow according the defined
Boundary Offset.

Sync edges with the boundary line
To ensure the part never exceeds the construction lines, regardless the edge type, you can

now synchronize the edge with the boundary line.
Select the edge to work on

I n the Properties panel, you can now easily select the edge you want to work on.

Texture Mapping
To support a more advanced texture editing, you can now do a texture mapping.
You can add several parts to the texture mapping, ensuring texture continuity between parts - by
defining the common deformation/ control line shared by both parts. 
On the mapped texture, you can create mapping deformations using deformation lines or deformation
points.
You can also select a control or deformation line and turn it in straight line – a reference line for
texture mapping.

Lines and Parts on Adjacent Surfaces
You can create lines crossing adjacent surfaces, i. e., lines running from the last bottom into the last
sole, for example. Thus, using this type of lines, you can also create parts crossing more than one
surface.

Merge Parts on Adjacent Surfaces
You can merge adjacent parts belonging to different surfaces.

New Object Selection Feedback
Now, when you select an object, only its surround is highlighted with a red line (by default). This
allows you to see the true color of the object material – in previous versions all surfaces of the object
changed to red. You can also change the selection color and the outline thickness.
With this new selection method, it is possible to view the selected objects, even when they were
created inside the last.

Surface lines visibility
Whatever surface you are working with, all lines on all surfaces will be visible. You can also set the
lines' transparency level. 

1.8.3 2015.V1

MindCAD 3D Design & Engineering® 2015.V1 release offers the following new features and fixes:

Design Accelerators

General interaction optimizations
Faster interaction while interacting with 3D models. Faster rebuild of parts.

Enhanced parallel lines tool
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Enabling multiple parallel lines to be defined with controllable displacement and repetition
parameters.

Enhancements in information visualization
The lines layer is now widely visible. Visibility of design elements across multiple primary

surfaces are now controlled upon user request. This will enhance the user experience and speedup
modelling when referencing between elements is critical. Also, some icons were revised and turned
to be DPI insensitive for a sharper visual experience.

Additional parameterization of pipes
Including a new Independent Offset option in Pipe Properties. This allow for a more flexible

positioning process of pipes without losing their dependency with constructive design lines.
Major revision of pipes and laces tools

Improved usability for both tools was done for consistency across multiple user scenarios.
Enhancements on copy & paste

Support for copy & paste of accessories single elements, as already possible for lines,
punches and punch groups. Faster copy paste of line elements through the usage of CTRL modifier.

Revised annotation tool
Critical for collaboration, annotation tool have been massively revised to provide a consistent

and faster setup process. Changes were made in both 3D Design & Engineering and 3D Viewer
products.

Accessories editor dimensions
It is now possible to configure accessory editor workspace dimensions to handle bigger

elements.

1.8.4 2016.V1

MindCAD 3D Design & Engineering 2016.V1 release offers the following new features and
enhancements:

DESIGN FEATURES

Design Accelerators
New Editable Surface component

Supporting design of flip-flops.
Multiple line offset tool

Enhanced tool for multiple parallel line offset, including now editing of multiple offset dependencies.
Texture deformation tool

Enhanced texture selection and deformation.
Enhanced edit area for punches

Revised and re-dimensioned working edit area for custom punches.
Revised interfaces

On Edit menu, Copy Tool now follows Clipboard.
Updated options on  Padder context menu.

Usability and Productivity
3D stencil AI support

Native Adobe Illustrator support for 3D stencils.
3D stencil enhanced interface

Revised interface for 3D stencils, including new toolbar options: Fix Projection and Fix Rotation.
3D stencil enhanced rendering

A more consistent 3D stencil rendering is now supported.
3D stencil live update

Live update of 3D stencils is now supported: changes on the original image used as stencil is
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automatically updated on the 3D stencil.
3D stencil real-time projection

Real-time projection of 3D stencils is now supported.
Clone visual properties between projects

New copy tool feature, supporting cloning of visual properties between projects.
Controlled re-mesh of parts

Enhanced mesh transformation process, for re-mesh of parts. Mesh quality and re-mesh parameters
can be changed on part´s Common Properties.

Delayed part edge reconstruction
Parts edge reconstruction is now controlled by "Disable automatic rebuild of 3D objects" view option.

Enhanced  folder organization of Texture library
Better folder management of Texture Library, including support for sub-library creation.

Enhanced quality lines
Better quality lines while traversing top level surfaces. C1 continuity is now guaranteed, while
connecting lines between adjacent surfaces.

Faster activation of top level surfaces
Top level surfaces are now automatically activated. Just press the <Shift> key and left-click over the
required surface.
New option Activate Surface on Selection. 

Merge of adjacent parts
New part merge tool feature, supporting automatic merging of adjacent parts.

Merge of merged parts
Support for merging of already merged parts.

Merge Parts: keep original parts on merge
New option to merge of several parts on the same primary surface, keeping the original parts.

Merge Parts: control of merge tolerance
The merge tolerance is now variable.

Non-square textures support
Aspect ratio correction for non-square textures.

Enhanced quality parts
Texture coordinates on parts that cross both center lines (heel/ front) have now better quality.

Part generation from top level surfaces merging
New part generation method, based on top level surfaces merging (last and sole).

Revised part collection algorithms
Revision of part collection algorithms to better cope with border lines.

Offset lines for soles
Enhanced quality offset lines for soles

Interoperability
Automatic centering of 3D content on export

Automatic centering of 3D content for all export options.
STEP support for accessories

The accessories library now supports STEP for imported accessories.

DESIGN WITH ADVANCED MATERIALS
Global finishing effects

New tools are now available for you to apply finishing effects on the final models.
New finishing effects tool

Only allows either finishing effects or stencils.
Additional interface to restrict finishing scope to object sets.
Created a new UI mechanism to avoid dismissing finishing FX dialog box (under some
circumstances).

Better materials and overall rendering quality
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MindCAD 3D D&E now boasts a state of the art physically based renderer, which allows
photorealistic material rendering in real time. 
This will allow you to see your models come to life as you model them, instead of relying on slow
exports to other 3D renderers (with even slower rendering times) or being constricted to non-
photorealistic real time rendering like our competitors. 
New advanced materials have been introduced. These materials’ properties can be changed in
runtime, allowing you to have infinite and very diverse representations of the same base material.
MindCAD supports now material importing from industry leading’s Substance Designer, from
Allegorithmic, as well as a new revolutionary material creation, that allows you to generate a
physically based material from a simple texture. 
Simply import your texture, tweak a few parameters to tell MindCAD D&E 2016 how it should react
physically, and to transform your texture into a photorealistic material.

Creation of advanced materials through texture import
Easier generation of advanced materials through texture import.

Easy generation of advanced materials
Implement furriness through texture import.

Environment mapping
MindCAD 3D D&E now supports an enhanced environment mapping.

Enhanced visual quality of materials
Enhanced visual quality of materials by integration of PBR shader.

HDR texture support
Enhanced precision of the environment map texture. HDR texture is now supported. Loading of
textures with more than 8 bit/ channel is now supported.

IBL support
Image-based lighting is now used as a 3D rendering technique for greater realism.

Skybox support
Environment mapping and IBL are now unified.

Optimized library loading time
The library was optimized to cope with the advanced materials loading time.

Usability optimization for importing multiple materials at once
Advanced materials import works for multiple materials at once and directories (with the option of
recursively go into subdirectories).

Ordering by name inside libraries
Materials in library are ordered by name.
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2 File Overview

This menu lets you open, close and save files, as well as create new ones. It also lets you open and
close annotations, load soles, transfer your existing design to a new last, export and import data, set
your preferences and access the print options.

2.1 File - New

This is the same as clicking the Create new project  button in the Main toolbar or pressing

Ctrl+N.

This is used to select a Last from a central database. 

Insert the server, user and password and press Ok.
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The follow window will appear.

To open a file from PDM, select the desired one and select Open.
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To open a standalone file, select the Open from file button and select the file to open.
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2.2 File - Open

This is the same as clicking the Open Project  button in the Main toolbar or pressing Ctrl

+O.

Use this option to open any of your projects from a central database.

Insert the server, user and password and press Ok.

The follow window will appear.
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To open a file from PDM, select the desired one and select Open.
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To open a standalone file, select the Open from file button and select the file to open.
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2.3 File - Close

This is the same as clicking the X button in the corner of any 3D window.

Use this option to close the current project.

2.4 File - Save

This is the same as clicking the Save Project  button in the Main toolbar or pressing Ctrl+S.

Use this option to save the current project with the current name to a central database.
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2.5 File - Save As...

This option allows you to save the current project in a different store and with a different name.

2.6 File - Import

The import menu has different options enabled, depending on which window is active.

2.6.1 File - Import - from IGES

Use this option to import an IGES file with style lines. Those lines are projected to the last's surface.
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2.6.2 File - Import - from Generic 2D

Use this option to import lines from 2D formats.

1. Select from Generic 2D from the Import options of the File menu.

2. Select the required import format from the available ones.
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2.6.3 File - Import - Texture...

Use this option to import textures.

There are two ways of importing an image:
by scanner, in which the operator has to Select device first and then Acquire.
by file, in which the operator simply selects an image file by using Read file.

After this import stage, the operator can post process the image using the following options:

Make greyscale - turns the imported image greyscale by using the image intensity channel.
Tile - when checked generates an image that is the result of tiling the original image to allow
circular continuity on the edges.
Offset - percentage of blend overlap for image continuity.
Create transparency channel - Enable or disable create transparency channel (please refer to
Creating a transparent texture for details)

- Based on intensity - Enable or disable based on intensity.
- Invert - Enable or disable invert.

- Based on color mask - Enable or disable based on color mask.
- Color - Select the color to be used a the reference for the mask.
- Tolerance - Select tolerance or spread from the reference color.

Preview - used to preview the generated image.

When the generated image is corrected then the Save button should be activated.
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A material with a given Name and default parameters is generated on a chosen Material Library.

2.6.4 File - Import - Accessory

Use this option to import accessories.
There are two ways of importing an accessory:

From file 

1. Click in the Browse button and choose the accessory file. There are several format available:
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2. In order to apply smoothing to the imported model by checking Smooth surface edges, this
options isn't available for all formats.

3. Save the accessory library by pressing Save.

From selection 

1. select the part to be imported as an accessory on the 3D view.

2. choose menu option File>Import>Accessory>from Selection

3. choose the library or create a new one by pressing Make Library.

4. write a name for the accessory on the Name field.

5. press OK to save the accessory.
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2.6.5 File - Import - Stitch

Use this option to import a stitch.
There are two ways of importing a stitch

From file

1. Click in the Browse button and choose the stitch file. There are several formats available:

2. To apply smoothing to the imported model check Smooth surface edges, this option isn't
available for all formats.

3. Save to the stitch library by pressing Save.
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From selection 

1. select the parts to be imported as a stitch on the 3D view.

2. choose menu option File>Import>Stitch>from Selection

3. choose the library or create a new one by pressing Make Library.

4. write a name for the stitch on the Name field.

5. press OK to save the stitch.
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2.6.6 File - Import - Punch

Use this option to import a punch. A punch can be imported in the following formats:

2.6.6.1 File - Import - Punch - BGD

Allows a user to import a punch or punches in BGD format.

1. Select the BGD file type from the Import and Punch options of the File menu.

2. Select the file containing the punch shapes.

3. Select the appropriate option form the warning dialogue box.
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4. Select the appropriate punch library name.

5. Click OK. The punches will be added to the library.

2.6.6.2 File - Import - Punch - DGT

Allows a user to import a punch or punches in DGT format.

1. Select the DGT file type from the Punch options on the Import option on the File menu.

2. Select the file containing the punch shapes.
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3. Select the appropriate option form the warning dialogue box.

4. Select the appropriate punch library name.
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5. Click OK. The punches will be added to the library.

2.6.6.3 File - Import - Punch - DXF

Allows a user to you import a punch or punches in DXF format.

1. Select the  DXF file type from the Import options on the Punch options of the File menu.

2. Select the file containing the punch shapes.
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3. Select the appropriate option form the warning dialogue box.

4. Select the appropriate punch library name.

5. Click OK. The punches will be added to the library.

2.6.6.4 File - Import - Punch - HPGL

Allows a user to import a punch or punches in HPGL format.

1. Select the HPGL file type from the Import options on the Punch options of the File menu.

2. Select the file containing the punch shapes.
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3. Select the appropriate option form the warning dialogue box.

4. Select the appropriate punch library name.
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5. Click OK. The punches will be added to the library.

2.6.6.5 File - Import - Punch - ISO

Allows a user to import a punch or punches in ISO format.

1. Select the ISO file type from the Import options on the Punch options of the File menu.

2. Select the file containing the punch shapes.
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3. Select the appropriate option form the warning dialogue box.

4. Select the appropriate punch library name.

5. Click OK. The punches will be added to the library.

2.6.6.6 File - Import - Punch - PDF

Allows a user to import a punch or punches in PDF format.

1. Select the PDF file type from the Import options on the Punch options of the File menu.

2. Select the file containing the punch shapes.
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3. Select the appropriate option form the warning dialogue box.

4. Select the appropriate punch library name.
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5. Click OK. The punches will be added to the library.

2.6.7 File - Import - Colors...

With this option, import of multiple colors is possible from an CSV file (Comma Separated Values).

1. choose the option File - Import - Color...

2. then select a CSV file. The format of this file should be as depicted below

3. the new colors will be imported into the current library.
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2.6.8 File - Import - Batch Material Generation

With this option, import of multiple textures is possible. The operator must choose a texture folder.
All the supported texture files on that folder are imported and corresponding new materials are
created with default values.

2.7 File - Export

The export menu has different options, depending on which window is being used.

In the 3D window

3D exportation Order:

1. Export the selected items;
2. If nothing is selected, then will export the visible items;

In the 2D window (flattening)

      

Use these options to export the current project to other software packages.
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2.7.1 File - Export - to MindCAD 3D Viewer

This option lets you export the current project to MindCAD 3D Viewer.

1. Select to MindCAD 3D Viewer from the Export options of the File menu

2. Enter the name for the exported project in the Save As dialogue box.

3. Select Save.

2.7.2 File - Export - to MindCAD 2D Document

This option lets you export the current project to one MindCAD 2D Document, MCD format.

2.7.3 File - Export - to Local Part Flattening

Use this option to export to Local Part Flattening. 

Select the parts you want to export first and then select the export format.

The parts flattening can be exported in the following formats:
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2.7.3.1 File - Export - to Local Part Flattening - BGD

This option lets you export the selected parts to BGD format.

1. Select BGD from to Local Part Flattening, in the export options of the File menu.

2. Processing the BGD format exportation:

3. Enter the name for the exported project in the Save As dialogue box.
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4. Select Save.

2.7.3.2 File - Export - to Local Part Flattening - DGT

This option lets you export the selected parts to DGT format.

1. Select DGT from to Local Part Flattening, in the export options of the File menu.

2. Processing the DGT format exportation:

3. Enter the name for the exported project in the Save As dialogue box.
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4. Select Save.

2.7.3.3 File - Export - to Local Part Flattening - DXF

This option lets you export the selected parts to DXF format.

1. Select DXF from to Local Part Flattening, in the export options of the File menu.

2. Processing the DXF format exportation:

3. Enter the name for the exported project in the Save As dialogue box.
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4. Select Save.

2.7.3.4 File - Export - to Local Part Flattening - IGES

This option lets you export the selected parts to IGES format.

1. Select IGES from to Local Part Flattening, in the export options of the File menu.

2. Processing the IGES format exportation:

3. Enter the name for the exported project in the Save As dialogue box.
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4. Select Save.

2.7.3.5 File - Export - to Local Part Flattening - PDF

This option lets you export the selected parts to PDF format.

1. Select to PDF from to Local Part Flattening, in the export options of the File menu.

2. Processing the PDF format exportation:

3. Enter the name for the exported project in the Save As dialogue box.
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4. Select Save.

2.7.3.6 File - Export - to Local Part Flattening - Printer

This option lets you export the selected parts to Printer format.

1. Select Printer from to Local Part Flattening, in the export options of the File menu.

2. Processing to export to Printer:

3. The printer window will open. To print press ok.

2.7.4 File - Export - to Generic 3D

This option lets you export the current project into a 3D format.

1. Select to Generic 3D from the Export options of the File menu.

2. Select the required export format from the available ones.
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2.7.4.1 File - Export - to Generic 3D - STL

This option lets you export the current project into STL format. Using this format, all objects will be
exported without textures.

1. Select STL files from the Save as type options of the Save As dialogue box.

2. Enter the name for the exported project in the Save As dialogue box.
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3. Select Save.

4. If the Apply Original Orientation option is checked, the imported objects will appear with the
initial orientation (as before imported into MindLast). 

If not, they will be imported without any changes. 
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5. Select Next.

6. Select the STL parameters. Choose between Binary or ASCII STL. The user can also choose if
what's to export the object(s) into a single file or if want to have one file for exported object. As an
example, if the user wants to export entire model and this option is checked, the model will be
exported into just one file; otherwise a file for each for object will be created. 

7. Select Next.
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8. This dialog box allows to configure the triangles size (mm). If the Keep Current Value option is
checked, the triangles will have the same size after the exportation; otherwise the user must
insert the size value  for the triangles. Note that this options only affects the parts, the remaining
exported objects will not be affected by this option.

9. Select Finish.

10.The STL format exportation will be processed:

2.7.4.2 File - Export - to Generic 3D - OBJ

This option lets you export the current project to the OBJ format. This format is commonly used in
Autodesk Maya, among others.

1. Select OBJ files from the Save as type options of the Save As dialogue box.

2. Enter the name for the exported project in the Save As dialogue box.



68 MindCAD 3D Design & Engineering

© 2016 Mind - Software Multimedia e Industrial, SA

3. Select Save.

4. If the Apply Original Orientation option is checked, the imported objects will appear with the
initial orientation (as before imported into MindLast).

If not, they will be imported without any changes. 



69File Overview

© 2016 Mind - Software Multimedia e Industrial, SA

5. Select Next.

6. This dialog box allows to configure the triangles size (mm). If the Keep Current Value option is
checked, the triangles will have the same size after the exportation; otherwise the user must
insert the size value  for the triangles. Note that this options only affects the parts, the remaining
exported objects will not be affected by this option.

7. Select Finish.

8. The OBJ format exportation will be processed:

2.7.4.3 File - Export - to Generic 3D - DXF

This option lets you export the currently selected lines into DXF format. For further information
please refer to File - Export - to Generic 3D - OBJ

2.7.4.4 File - Export - to Generic 3D - IGES

This option lets you export the currently selected lines into IGES format. This format only exports
lines, points and lasts.

1. Select IGES files from the Save as type options of the Save As dialogue box.

2. Enter the name for the exported project in the Save As dialogue box.
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3. Select Save.

4. If the Apply Original Orientation option is checked, the imported objects will appear with the
initial orientation (before imported into MindLast). 

If not, they will be imported without any changes. 
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5. Select Finish.

2.7.4.5 File - Export - to POV-Ray

This option lets you export the current project to POV-Ray. POV-Ray is free software that lets you

produce a very realistic, ray traced image. It can be downloaded from www.povray.org

1. Select POV-Ray files from the Save as type options of the Save As dialogue box.

2. Enter the name for the exported project in the Save As dialogue box.
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3. Select Save.

4. Select the environment:

The images below show the four available environments:

Checker: Grass:
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Ocean: White Background:

5. Select OK.

6. This dialog box allows to configuring the triangles size (mm). If the Keep Current Value option is
checked, the triangles will have the same size after the exportation, otherwise the user have to
insert the size value for the triangles. Note that this options only affects the parts; the remaining
exported objects will not be affected by this option.
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7. The POV-Ray format exportation will be processed:

2.7.4.6 File - Export - VRML

This option lets you export the current project to VRML format. For further information please refer
to File - Export - to Generic 3D - OBJ

2.7.4.7 File - Export - 3DM

This option lets you export the current project to 3DM. For further information please refer to File -
Export - to Generic 3D - OBJ

2.7.4.8 File - Export - U3D

This option lets you export the current project in U3D format. For further information please refer to
File - Export - to Generic 3D - OBJ
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2.7.4.9 File - Export - PDF3D

This option lets you export the current project in PDF 3D format.

2.7.5 File - Export - to Image

This option lets you export the current window as an image. The image can be exported in the
following formats:

.bmp

.jpg

.jpeg

.png

.tga

1. Select to Image from the Export options of the File menu

2. Enter the name for the exported project in the Save As dialogue box, select the destination folder
and choose the desired format.

3. Select Save.

4. Select the image size and press finish.
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2.7.6 File - Export - BGD

Use these options to export the current project to 2D Design & Engineering.

2.7.6.1 File - Export - BGD - Folded upper

Export the folded upper of the current project to 2D Design & Engineering.
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2.7.6.2 File - Export - Unfolded upper

Export the unfolded upper of the current project to 2D Design & Engineering.

2.7.6.3 File - Export - Bottom

Export the bottom of the current project to 2D Design & Engineering.
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2.7.6.4 File - Export - BGD - Upper + Bottom

Export the folded upper and bottom of the current project to 2D Design & Engineering.

2.7.7 File - Export - DGT

Use these options export the current project in DGT format.
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2.7.7.1 File - Export - DGT - Folded upper

Export the folded upper of the current project in DGT format.

2.7.7.2 File - Export - DGT - Unfolded upper

Export the unfolded upper of the current project in DGT format.
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2.7.7.3 File - Export - DGT - Bottom

Export the bottom of the current project in DGT format.

2.7.7.4 File - Export - DGT - Upper + Bottom

Export the folded upper and bottom of the current project in DGT format.

2.7.8 File - Export - DXF

Use these options export the current project in DXF format.
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2.7.8.1 File - Export - DXF - Folded upper

Export the folded upper of the current project in DXF format.

2.7.8.2 File - Export - DXF - Unfolded upper

Export the unfolded upper of the current project in DXF format.
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2.7.8.3 File - Export - DXF - Bottom

Export the bottom of the current project in DXF format.

2.7.8.4 File - Export - DXF - Upper + Bottom

Export the folded upper and bottom of the current project in DXF format.
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2.7.9 File - Export - IGES

Use these options export the current project in IGES format.

2.7.9.1 File - Export - IGES - Folded upper

Export the folded upper of the current project in IGES format.

2.7.9.2 File - Export - IGES - Unfolded upper

Export the unfolded upper of the current project in IGES format.
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2.7.9.3 File - Export - IGES - Bottom

Export the bottom of the current project in IGES format.

2.7.9.4 File - Export - IGES - Upper + Bottom

Export the folded upper and bottom of the current project in IGES format.

2.7.10 File - Export - PDF

Use these options export the current project in PDF format.
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2.7.10.1 File - Export - PDF - Folded upper

Export the folded upper of the current project in PDF format.

2.7.10.2 File - Export - PDF - Unfolded upper

Export the unfolded upper of the current project in PDF format.
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2.7.10.3 File - Export - PDF - Bottom

Export the bottom of the current project in PDF format.

2.7.10.4 File - Export - PDF - Upper + Bottom

Export the folded upper and bottom of the current project in PDF format.
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2.8 File - Project Info

Select Project info from File menu, this lets you keep a record of any information regarding your
project.

You might keep version numbers, personal comments, material references or any other information

in this area.
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2.9 File - Preferences

Use this option to define system values of working folders, colours, customize tool parameters,
language and data store.
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2.9.1 File - Preferences - Folders

Use these options to set your preferred directories and to enable or disable the auto save option.

Recovery

Enable auto save - Active this option to enable an automatic periodic saving of your work. Change
the auto save frequency on Time (min) field.

Folders

Select the corresponding folder by using the  Browse button.
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2.9.2 File - Preferences - Editing

Reference 

Preferred colour and thickness for the reference elements.

Lines

Preferred colour, thickness and smoothing option for the style lines.

Parts

Preferred thickness, inside and outside materials, edge geometry and propagation of inside or
outside materials to the edge.
Local flattening's, flattening method and maximum triangles per flattening.

Stitches

Default Material - Preferred color and other properties for the stitches material

Accessories

Default Material - Preferred colour and other properties for the accessories material
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Pipes

Preferred wide, height and material of created pipes.

Markers

Default Material - Preferred colour and other properties for the markers material

Last

Default Material - Preferred colour and other properties for the last material.

Full Flattening Method - This is the flattening method is used for the flattening's made in
background, it's possible to choose between Angle Base or Distance Base.

Units

Default Material - Preferred colour and other properties for units material.

2.9.3 File - Preferences - Display

Use these options to set your preferred interface and view settings.

1. Interface 
a) Language
Select your preferred language from the Language drop down list.

b) Application Theme
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Select the application theme using the browse button .

There are four options available.

c) Monitor horizontal size (mm)
Tick User defined Horizontal width of the monitor to specify the dimensions of your monitor.

2. 3D View
a) View settings
Preferred initial 3D view settings.

b) Enable high quality time delay
Tick this option to set delay value (ms). To control the delay between the regular fast visualization
mode and the activation of the high quality rendering mode. Set this value to 0 (zero) if you want to
work always in high quality mode.

c) Automatic "Zoom To Fit" when changing camera view
Check this option to automatically "Zoom to fit" when the point of view is changed.

3. 2D View

a) 2D background colour
Preferred colour for the 2D background where the lines are displayed on. The background option has
one colour that can be set.

b) Draw quality
Select Fast or Quality mode.
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2.9.4 File - Preferences - Misc

1. Print Options
a) Print Logo - It's possible to print one logo with 3D image.

To select the logo file press the  Browse button.

b) Print project notes
Print project notes with preferred font and alignment of text.

2. Part Assessment
a) Group settings
Base angle - Enter the base angle value

Mode - Press the  Browse button to select the mode

b) Method - Press the  Browse button to select the method
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c) Parts margin - Enter the parts margin value.

3. Clear 'Don't show again' flags

Press the clear to reset the option, like the one below. This way the program will ask again the
question, instead of doing what the user select as default.

2.10 File - Print

This is the same as clicking the Print  button in the Main toolbar or pressing Ctrl+P.

Use this option to print any select object (for example, line, part, accessory, stitch, punch).

2.11 File - Print Preview

Use this option to preview a print out.

2.12 File - Printer Setup

Use this option to set up your printer.

2.13 File - file list

Use this option to open a recently used project. The last four projects names are displayed for quick
selection.
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2.14 File - Exit

Use this option to exit the program.





Part

III
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3 Edit Overview

This menu lets you carry out some of the editing commands, it also allows you to undo edits that
have been made, and restrict editing of items that are correct.

3.1 Edit - Change

This is the same as, doing a right click over one object and select the option Properties.

1. Select one object, take a line as example.

2. Select Change from the Edit menu.
3. The Properties tab will open, and show the line properties.
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3.2 Edit - Undo

This option undoes the last editing command.

This is the same as clicking the Undo  button in the Main toolbar or pressing Ctrl+Z
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3.3 Edit - Redo

This option is under development, and will redo the last Undo command.

This is the same as clicking the Redo  button in the Main toolbar or pressing Ctrl+Y

3.4 Edit - Clipboard

This menu lets you, cut, copy, paste or delete selected objects, it also allows to select all objects or
reverse the current selection. 

3.4.1 Edit - Clipboard - Cut

This option cuts the currently selected items. Cut copies the selected items to the paste buffer, then
deletes the selected items.

This is the same as clicking the Cut  button in the Main toolbar or pressing Ctrl+X

3.4.2 Edit - Clipboard - Copy

This option copies the currently selected items into the paste buffer.

This is the same as clicking the Copy  button in the main toolbar or pressing Ctrl+C
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3.4.3 Edit - Clipboard - Paste

This option pastes the contents of the paste buffer (filled by cut or copy) into the current window.

This is the same as clicking the Paste  button in the Main toolbar or pressing Ctrl+V

3.4.4 Edit - Clipboard - Delete

This option deletes the currently selected items. This is the same as pressing the delete key on your
keyboard.

3.4.5 Edit - Clipboard - Select All

This option selects all items. This is the same as pressing Ctrl+A

3.4.6 Edit - Clipboard - Reverse Selection

This option allows to reverse the current selection.

3.5 Edit - Copy Tool

This is the same as clicking the Properties selection  button in the General 3D toolbar.

Use this option to copy properties of an object ( thickness, offset, material, line style, scale and pipe

type) and apply them on other objects.

1. Select Properties selection from the Selection option of the Tools menu. The cursor will be
displayed

As the cursor is moved over the image, the object with the properties to be copied will highlight.

2. Press Ctrl and left mouse button to copy all the properties of the object. 

The cursor will be displayed  when the Ctrl are pressed.

3. To select individual properties press the right mouse button and select the required properties from
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the menu using the left mouse button.

The cursor will be displayed  when the properties have been copied.

Note: To apply the properties copied to all visible objects, do a right click  and select the option
Apply to visible objects.

4. Move the cursor to the objects to have these properties applied to them and press the left mouse
button.

Note: The copied properties can be applied to objects in other projects.

3.6 Edit - Grouping

This menu lets you group and ungroup lines.
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3.6.1 Edit - Grouping - Group

This option lets you treat a number of lines as a single object. If any line within a group is selected
all the other lines in the group will be selected as well.

1. Select the lines that you wish to make into a group.
2. Select Group from the Grouping options in the Edit Menu

3.6.2 Edit - Grouping - Ungroup

This option lets you return lines within a group to individual lines.

1. Select any line in a group.
2. Select Ungroup from the Grouping options in the Edit Menu

3.6.3 Edit - Grouping - Ungroup All

This option lets you return all the lines within groups to individual lines.

1. Select Ungroup All from the Grouping options in the Edit Menu.

3.7 Edit - Locking

This menu lets you lock and unlock items.

3.7.1 Edit - Locking - Lock

This lets any line or 2D polygon to be frozen, if an item is frozen it cannot be edited.

1. Select items to be frozen.
2. Select Lock from the Locking options in the Edit Menu.
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3.7.2 Edit - Locking - Unlock

This lets frozen items which cannot be edited become editable again.

1. Select items to be unfrozen.
2. Select Unlock from the Locking options in the Edit Menu.

3.7.3 Edit - Locking - Unlock All

This lets all the locked items which cannot be edited become editable again.

1. Select Unlock All from the Locking options in the Edit Menu.

3.7.4 Edit - Locking - Disable Automatic Rebuild

Active this option to disable the automatic rebuild of the objects, when editing the lines that compose
them.

This is the same as clicking the Disable automatic rebuild of 3D objects  button in the
General 3D toolbar.

3.8 Edit - Visibility

This menu lets you hide and show items.

3.8.1 Edit - Visibility - Hide

This option allows to temporarily hide any selected items.

This is the same clicking the Hide Selection  button in the general 3D toolbar.
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3.8.2 Edit - Visibility - Show all

This option allows to show all hidden object, or select the type that you want to show.

3.9 Edit - Constrains

All options to control which surfaces are for current editing operations and options to let you 'snap'

editing or drawing operations to specific points.
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3.9.1 Edit - Constrains - Draw on both sides

This is the same as clicking the Enable Side Crossing Lines  button in the Constrain
toolbar.

This allows to draw lines not constrained to a specific side of the last.

3.9.2 Edit - Constrains - Medial

This is the same as clicking the Work on Medial  button in the Constrain toolbar.

This restricts all editing and drawing operations to the inside half of the last upper.
The first time this option is used after selecting inner sole or none options, both the inner and outer of
the upper are selected automatically. A second click on the button will make the selection active.

Other way to active the Top level surface is by pressing the <Shift> key and left-click over the
required surface.

3.9.3 Edit - Constrains - Lateral

This is the same as clicking the Work on Lateral  button in the Constrain toolbar

This restricts all editing and drawing operations to the outside half of the last upper.
The first time this option is used after selecting inner sole or none options, both the inner and outer of
the upper are selected automatically. A second click on the button will make the selection active.

3.9.4 Edit - Constrains - Inner Sole

This is the same as clicking the Work on bottom  button in the Constrain toolbar.

This restricts all editing and drawing operations to the last bottom.

Other way to active the Top level surface Bottom is by pressing the <Shift> key and left-click over
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the required surface.

3.9.5 Edit - Constrains - None

This is the same as clicking the Deactivate Every Surface  button in the Constrain toolbar.

This restricts all editing operations to the shoe bottom parts (sole, heel, and so on).

3.9.6 Edit - Constrains - Nearest Line

This is the same as clicking the Nearest Line  button in the Constrain toolbar.

This lets all editing and drawing operations snap to the nearest line, when the cursor is close to it.

You can use any combination of the 'Nearest' options together. This lets you select all options if you

want the snap options to work to their full capabilities.

3.9.7 Edit - Constrains - Nearest Intersection

This is the same as clicking the Nearest Intersection  button in the Constrain toolbar.

This lets all editing and drawing operations snap to the nearest intersection between lines, when the

cursor is close to it.

You can use any combination of the 'Nearest' options together. This lets you select all options if you

want the snap options to work to their full capabilities.
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3.9.8 Edit - Constrains - Nearest End

This is the same as clicking the Nearest End  button in the Constrain toolbar.

This lets all editing and drawing operations snap to the nearest line end, when the cursor is close to

it.

You can use any combination of the 'Nearest' options together. This lets you select all options if you

want the snap options to work to their full capabilities.

3.9.9 Edit - Constrains - Nearest Point

This is the same as clicking the Nearest Point  button in the Constrain toolbar.

This lets all editing and drawing operations snap to the nearest point on line when the cursor is close

to it.

You can use any combination of the 'Nearest' options together. This lets you select all options if you

want the snap options to work to their full capabilities.

3.9.10 Edit - Constrains - Nearest Grid

The grid option is only available in a 2D (flattening) window

This is the same as clicking the Nearest Grid  button in the Constrain toolbar.

This lets all editing and drawing operations snap to the grid, when the cursor is close to it.

On a grid line the centre of the cursor will turn blue 

On a grid intersection the centre of the cursor will turn red 
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You can use any combination of the 'Nearest' options together. This lets you select all options if you

want the snap options to work to their full capabilities.

3.9.11 Edit - Constrains - Drag Constrain

This allows to control whether a line(s) can be dragged (moved), rotated or scaled.

When the cursor is over a line(s) and displayed as a cross  it is possible to drag, rotate and

scale the line(s) if Drag Constrain is OFF.

This menu lets you carry out editing commands and specify the names and number, of design and
measurement elements you require.

This is the same as clicking the Drag Constrain  button in the Constrain toolbar or

pressing F11.

3.9.12 Edit - Constrains - Activate Surface on Selection

Enable/disable the activation of surface on selection.

With this option enable, is possible to active top level surfaces by clicking over it, using the select

tool .
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3.10 Edit - Thickness

These options let you control the thickness of parts.

3.10.1 Edit - Thickness - Increment

This is the same as clicking the Increment thickness  button in the Offsets toolbar. The

increment value could be changed directly on the edit box  near the button. The default

value is 0.5mm.

This option is used to add a specific value to the thickness of the selected part(s).

3.10.2 Edit - Thickness - Decrement

This is the same as clicking the Decrement thickness   button in the Offsets toolbar. The

decrement value could be changed directly on the edit box  near the button. The default

value is 0.5mm.

This option is used to remove a specific value from the thickness of the selected part(s).

3.10.3 Edit - Thickness - Set to 0.5 mm

This is the same as clicking the Thickness to 0.5mm  button in the Offsets toolbar. The

thickness value could be changed directly on the edit box  near the button. The default value

is 0.5mm.

This option is used to set the thickness of the selected part(s) to a specific value.
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3.11 Edit - Lifters

These options let you control how far the selected object is lifted from the last surface. Lifters can be

applied to lines, points, parts, accessories, stitches, and punches.

3.11.1 Edit - Lifters - Increment

This is the same as clicking the Increment height   button in the Offsets toolbar. The

increment value could be changed directly on the edit box  near the button. The default

value is 0.5mm.

This option is used to add a specific value to the surface offset of the selected objects.

3.11.2 Edit - Lifters - Decrement

This is the same as clicking the Decrement height  button in the Offsets toolbar. The

decrement value could be changed directly on the edit box  near the button. The default

value is 0.5mm.

This option is used to decrement a specific value from the surface offset of the selected objects.

3.11.3 Edit - Lifters - Place on surface

This is the same as clicking the Place on surface height  button in the Offsets toolbar.

This option is used to remove any surface offset of the selected objects and place them back on the
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last surface.

3.11.4 Edit - Lifters - Adjust height

Use this option to change the line height easily. Please see lifter lines.
 

1. Select Object selection from the Selection options on the Tools menu. The cursor will be
displayed.

2. Select the line to be edited.

3. Select Adjust Height from the Lifters options in the Edit Menu

4. As you approach a point on the selected line the cursor will change to a pen.

5. Press and hold down the left mouse button, as you move the mouse the point will move. To stop
the edit release the left mouse button.

6. Repeat on any point on the selected line.
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7. To finish press the right mouse button and select the Finish option from the menu.

3.12 Edit - Transform

This options allows you to align and rotate accessories and imported components. 

3.12.1 Edit - Transform - Free Rotation

Use this option to rotate any object using a three axis approach.

1. Select the object;

2. While hovering the axis dialers a bold feedback is provided

3. Just click and drag the dialer to the desired rotation, feedback of the angle is provided.
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3.12.2 Edit - Transform - Free Manipulator

This option is used to align components with the last. The components may have been imported from
another system and need to be aligned to the last.

1. Select the component to align;

2. Select the Free Manipulator under transform option in the edit menu, or do a right click over the
component and select Free Transform option.

3. The Aligning toolbar will appear.
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3.12.2.1 Free Manipulator - Select Component

To select the top level you want to align use the combobox.

3.12.2.2 Free Manipulator - Automatic Align

Use this option to start the automatic alignment process of the selected element.

Activate the Automatic alignment button from the Aligning toolbar. A dialog will appear stating the
four reference points needed for the process.

Input the points using the left mouse button. While defining the points you are free to rotate, drag and
scale the image for better positioning.

First Alignment Point on Object - Where this point should align with the First Alignment Point on
Last
Second Alignment Point on Object - Where this point should align with the Second Alignment
Point on Last
First Alignment Point on Last - Where this point should align with the First Alignment Point on
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Object
Second Alignment Point on Last - Where this point should align with the Second Alignment Point
on Object

After the points selection the component will be aligned automatically.

3.12.2.3 Free Manipulator - Manual Align

Use this option to start the manual alignment process of the selected component.

Activate Manual alignment from the Aligning toolbar. A reference system will appear with green
handles on the axis. By default, the first interaction mode is Move.

3.12.2.3.1  Free Manipulator - Manual Align - Move

Doing right click, choose the Move option

While in this interaction mode, it's possible to move the object along the X, Y and Z axis.
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Click over the green handles and drag them over the corresponding axis. This will move the object
into the desired direction. While moving the amount of displacement is displayed in mm. 

If there is the need to input an exact value for the alignment procedure, just right click over the green
handle and choose Set Value. A dialog appears where you can input the desired value.

Select Finish to finalize the manual alignment process.
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3.12.2.3.2  Free Manipulator - Manual Align - Scale

Doing right click, choose the Scale option

While in this interaction mode, scaling of the sole is possible along the X, Y and Z axis.

Click over the green handles and drag them over the corresponding axis. This will scale the sole in
the desired axis. While scaling the amount of scaling is displayed as a factor. 

If there is the need to input an exact value for the alignment procedure, just right click over the green
handle and choose one of the set value options, Set size value or Set scale value. 
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A dialog appears where you can input the desired value.

Select Finish to finalize the manual alignment process.

3.12.2.3.3  Free Manipulator - Manual Align - Rotate

Doing right click, choose the Rotate option

While in this interaction mode, rotation of the sole is possible along the X, Y and Z axis using the
displayed center as a pivot point.

1. While hovering the axis dialers a bold feedback is provided

2. Just click and drag the dialer to the desired rotation, feedback of the angle is provided.
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Click over the green handles and drag them over the corresponding rotation circle. This will rotate the
sole in the desired axis. While rotating the amount of rotation is displayed in degrees. 

If there is the need to input an exact value for the alignment procedure, just right click over the green
handle and choose Set Value. A dialog appears where you can input the desired value.

Select Finish to finalize the manual alignment process.
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3.13 Edit - Material Placement

This menu allows to change a material already applied to a part, sole etc. and to reset the material

to the original form.

3.13.1 Edit - Material Placement - Interactive Texture Mapping

This is the same as clicking the Texture selection  button in the General 3D toolbar.

Use this option to select a material already applied to a part, sole etc. and change the texture scale,

position and rotation.

1. Select Manual from the Material Placement option of the Edit menu. The following cursor will
be displayed

2. Select the part (or other object) with the texture to be edited using the left mouse button.

3. To move (slide) a texture, press and hold down the left mouse button. The texture will move
with the cursor.



122 MindCAD 3D Design & Engineering

© 2016 Mind - Software Multimedia e Industrial, SA

4. To rotate a texture, select the rotation point using Ctrl and the right mouse button. Move
slightly away from the selected point and press the right mouse button (a dotted line will be
displayed). Move the mouse and the texture will rotate (the angle is also displayed). When rotation
is correct, press the left mouse button to finish the sequence.

5. To scale a texture, press the Ctrl while also pressing and holding down the middle mouse button.
Moving the cursor up will increase the scale of the texture and moving the cursor down will
decrease the scale of the texture.



123Edit Overview

© 2016 Mind - Software Multimedia e Industrial, SA

To a more refined texture edition, it's possible to do a texture mapping, to enter this tool, with the
tool texture selection active, just do a double click over the texture, or do a right click and select the
option Add to Texture mapping.
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3.13.2 Edit - Material Placement - Add to Texture Mapping Editor

To a more refined texture edition, is possible to do a texture mapping.
To enter this tool, with the tool texture selection active, just do a double click over the texture, or do
a right click and select the option Add to Texture mapping.

It's possible to add several parts to texture mapping at the same time.

1. Select the desired parts and go to the menu Edit - Material Placement - Add to Texture Mapping
Editor, 

or

with the tool Texture selection , select the desired parts to add to texture mapping.

Do a right click and select Add to texture mapping.



125Edit Overview

© 2016 Mind - Software Multimedia e Industrial, SA

2. The parts will be added to texture mapping
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3.13.2.1 Deformation Line

1. Select the first part:

2. Click in the button Create Mapping Deformation Line , from the Texture Mapping tool
bar

3. Draw the Deformation Line, double click to finish.

4. When the line is finished, select the Select Button  from the Texture Mapping tool bar.
5. Now is possible to select and drag the line points.
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3.13.2.2 Deformation Points

1. Select the first part:

2. Click in the button Create Deformation Points , from the Texture Mapping tool bar.
3. Add the deformation points.
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4. When all the deformation point are placed, select the Select Button  from the Texture
Mapping tool bar.

5. Now is possible to select and drag the points.

6. To remove a point, hold down the shift button, approach the point to be deleted, the cursor will

change to a pen with a minus sign ( ).
Press the left mouse button to delete the point.

3.13.2.3 Deform line into another existing line

Deform line into another existing line

1. Select the first part:
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2. In the Texture Mapping tool bar, select the option Create a Control line 

3. Draw the control line

4. Select the second part and draw the contour Line.

5. To join the lines, select the first line

6. Select the Deform line into another existing line  from the Texture Mapping tool bar.
And select the second line.
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7. When the second line is selected, the lines will be joined, and the texture will be continued.

8. It's possible to do this process with several parts.
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3.13.2.4 Turn selected line into a straight line

1. Select the first part:

2. In the Texture Mapping tool bar, select the option Create a Control line .

3. Draw the control line, and select the line.

4. Select the Turn selected line into a straight line   from the Texture Mapping tool bar. 
5. Left click over the control line to select the point of rotation, move the mouse to change the
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position, and do other left click to finish.

6. The part will be adjusted. It's possible to see the texture mapping changes in the model.

3.13.3 Edit - Material Placement - Reset

This option allows to reset the texture to is original position and size.

This is the same as doing a right click over the selected texture when the tool Texture Selection is
activated and selecting the Reset option.



Part

IV
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4 View Overview

This menu lets you control what is displayed on the screen. You can use it to turn on or off, toolbars

and layers. You can also select a viewpoint or whether you are looking at the 3D image or the 2D

flattening.

4.1 View - Zoom to Fit

This option lets you scale any graphics, so that it fits onto the screen. This is the same as clicking

the Zoom to fit button  in the Main toolbar or pressing Ctrl+D.
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4.1.1 View - Zoom to Fit - Selected Elements

1. Select the element to Zoom in.

2. In the View menu, click in Zoom to fit option or in the Zoom to fit button  in the Main
toolbar. This is the same as pressing Ctrl+D.

3. The selected element will be zoomed in.

4. It's also possible to select more than one element and zoom in.
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4.2 View - Zoom 1:1

When this option is used, the graphics are scaled to the correct physical dimensions. If Zoom 1:1
doesn't work correctly, please go to the File - Preferences - Display and specify the correct value (in
mm) of your monitor.
This is the same as pressing Ctrl+Shift+D.

4.3 View - Point of View

This lets you view the 3D image from standard view points.

4.3.1 View - Point of View - Lateral

This is the option to view the 3D image from the outside. This is the same as clicking the Lateral

button  in the Views toolbar or CTRL + 4.

4.3.2 View - Point of View - Medial

This is the option to view the 3D image from the inside. This is the same as clicking the Medial

button  in the Views toolbar CTRL + 6.
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4.3.3 View - Point of View - Top

This is the option to view the 3D image from directly above. This is the same as clicking the Top

button  in the Views toolbar CTRL + 5.

4.3.4 View - Point of View - Bottom

This is the option to view the 3D image from directly underneath. This is the same as clicking the 

Bottom button  in the Views toolbar CTRL + 0.

4.3.5 View - Point of View - Toe

This is the option to view the 3D image from the toe. This is the same as clicking the Toe button

 in the Views toolbar CTRL + 8.

4.3.6 View - Point of View - Heel

This is the option to view the 3D image from behind. This is the same as clicking the Back View

button  in the Views toolbar CTRL + 2.
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4.3.7 View - Point of View - 3/4

This is the option to view more standard view points.

4.3.7.1 View - Point of View - 3/4 - Toe Lateral

This is the option to view the 3D image from half way between the toe and the outside views. This is

the same as clicking the Front Lateral button  in the Views toolbar CTRL + 9.

4.3.7.2 View - Point of View - 3/4 - Toe Medial

This is the option to view the 3D image from half way between the toe and the inside views. This is

the same as clicking the Front Medial button  in the Views toolbar CTRL + 7.

4.3.7.3 View - Point of View - 3/4 - Heel Lateral

This is the option to view the 3D image from half way between the heel and the outside views. This is

the same as clicking the Back Lateral button  in the Views toolbar CTRL + 3.
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4.3.7.4 View - Point of View - 3/4 - Heel Medial

This is the option to view the 3D image from half way between the heel and the inside views. This is

the same as clicking the Back Medial button  in the Views toolbar CTRL + 1.

4.3.8 View - Point of View - Previous

This is the option to go back to your previous point of view. This is the same as clicking the 

Previous button  in the Views toolbar.

4.3.9 View - Point of View - Camera

Allows to choose the point of view from camera. 

4.3.9.1 View - Point of View - Camera - Set Current View as

Choose the current camera view. 
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4.3.9.2 View - Point of View - Camera - Set Rotation Mode

Choose the rotation mode, restricted or free. 

.

Note: By default the rotation mode is defined as restricted.  

4.4 View - Environment

This menu allows to change between the environments and to edit the current one.
This is the same as changing the environment in View setting selector on the View Settings Bar.

4.4.1 View - Environment - Change

Use this option to move, add or edit the lights.

1. Select Change from the Environment options on the Change menu. The following cursor will be
displayed

The lights will also be displayed for editing
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2. The round light is the ambient light and cannot be edited.

The lights displayed as cones can be selected using the left mouse and holding it down and moved
to a new position.

3. to add new lights, just left click on the background away from existing lights

4. to delete lights, select the light and press the Delete key. 

5. to save a light setting, do a right mouse button click and choose Save setting. 
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To save to the current light setting, in this example, to save the changes for 6 lights (soft). If you
want to add a new light settings select the option New View Settings.

6. To delete a light setting, do a right mouse button click and choose the view settings, in case of
not being the current one. After having the view setting to delete selected do a right click and select 
Delete.

Select the required light view settings
 Select the option to delete the current 
light view setting
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7. To activate a light setting, do a right mouse button click and choose Change View Setting.
Select the required view setting.
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8. to restore all the factory light settings to their original values, do a right mouse button click and
choose Restore default settings.
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9. To edit a light, when selected, press the right mouse button and select Properties.

10. Use the Object Properties dialogue box to define the properties.
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To increase light intensity - Use the RGB sliders to adjust the light intensity.

To change the light colour - Set Link Values to OFF to allow individual colours to be changed.

4.5 View - Toolbars

This menu shows all the options for displaying toolbars.

4.5.1 View - Toolbars - Main Bar

This is the option to turn on/off the Main toolbar. It is recommended that this menu is always visible.
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4.5.2 View - Toolbars - Masking

This is the option to turn on/off the Masking toolbar.

4.5.3 View - Toolbars - Stencils

This is the option to turn on/off the Stencils toolbar.

4.5.4 View - Toolbars - Laces

This is the option to turn on/off the Laces toolbar.

4.5.5 View - Toolbars - Offsets Bar

This is the option to turn on/off the Offsets toolbar. It is recommended that this menu is always

visible.

4.5.6 View - Toolbars - View Settings Bar

This is the option to turn on/off the View Settings toolbar.

Use this toolbar to control the project settings and save them.

4.5.6.1 Configure View Settings

Use this option to configure the project settings.

1. The View settings selector allows you to change between settings previous configured.
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2. Click in the Create New Settings button  in the toolbar to create a new project setting.

A dialog is displayed for insert the setting name:

Press Ok and the new configuration is saved. To edit the setting press the button Edit Settings. 

3. Click in the Delete Settings button  in the toolbar to delete settings of the setting selector.

4. Click in the Edit Settings button  in the toolbar to change the settings.

5. Click in the Save Settings button  in the toolbar to save settings changes.

6. Click in the Orthogonal Projection button  in the toolbar to change the projection.

7.  - Perspective Projection button allows you to change the perspective, it's possible to alter

the angle through the Perspective field of view angle .
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8. Click in the Shadows Effect button  in the toolbar to enable or disable the shadows.
In the image we can see the difference between shadows on/off in a model.

9. Click in the Configure Background button  in the toolbar to configure 3D - Background.
The dialog Background color is displayed:
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Gradient Background - The background is displayed as a graded range of colour between the
Top colour and the Bottom colour 

Sky box - To provide an even more natural look, the user may select to visualize the IBL map as a
sky box around the model. 
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Solid Background - A single color is used for the background;

Image background - The user choose the image file and how to align it on your working area.

10.  Click in the Texture Mode button  in the toolbar to enable or disable the texture mode.

11. The Environment mapping image allows you to change the environment image, to supply a
model with indirect lighting.
Selecting a different IBL map greatly affects the look of the model’s materials. 
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4.5.7 View - Toolbars - General 3D Bar

This is the option to turn on/off the General 3D toolbar. It is recommended that this menu is always

visible.

4.5.8 View - Toolbars - Constrain Bar

This is the option to turn on/off the Constrain toolbar. It is recommended that this menu is always

visible.

4.5.9 View - Toolbars - Tools Bar

This is the option to turn on/off the Tools toolbar. It is recommended that this menu is always visible.
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4.5.10 View - Toolbars - Parts Bar

This is the option to turn on/off the Parts toolbar. It is recommended that this menu is always visible.

4.5.11 View - Toolbars - Paint Last

This is the option to turn on/off the Paint Last toolbar.

4.5.12 View - Toolbars - Views Bar

This is the option to turn on/off the Views toolbar.

4.5.13 View - Toolbars - Customize

This allows advanced interface customization.
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4.5.13.1 View - Toolbars - Customize - Commands

In the commands tab are available all the program commands, arranged by Categories.

The user can drag any command to the toolbars.
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4.5.13.2 View - Toolbars - Customize - Toolbars

Use these options to create your own toolbars and to reset the existing ones.

To add a customized toolbar please follow this sequence:

1. On the Toolbars tab, click New

2. Insert the name and press OK, the new bar will appear.

3. In the commands tab are available all the program commands, arranged by Categories
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4. Select the required command button and Drag and drop to the toolbar. To drag the command,
click over it with the left mouse button and keep it pressed

5. When the mouse button is over the toolbar, you can let go of the left mouse button
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6. The button will be added to the toolbar

 

7. To remove a button from the current toolbar, select the button and drag and drop it to the
commands list.

4.5.13.3 View - Toolbars - Customize - Keyboard

This option allows you to create your one keyboard shortcuts. 

1. Select the Category and the Command to add the shortcut.
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2. Select the text box Press New Shortcut Key and press keys to assign to add the shortcut.

3. To remove the shortcut, select it and press Remove.



159View Overview

© 2016 Mind - Software Multimedia e Industrial, SA

4. The button Reset All allows to set the original shortcut and delete the custom ones.

4.5.13.4 View - Toolbars - Customize - Menu
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Application Frame Menus

Select the desired menu to reset from the "Show menus for:" 

After selecting the menu, press the Reset button, the menus will return to the original state. 

Menu Animations 

It's possible to select animations for the menus.

Menu shadows - Enable/ Disable the menu shadows.
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4.5.13.5 View - Toolbars - Customize - Options

Toolbar

Show Screen Tips on toolbars - Enable/ Disable the tooltips
   - Show shortcut keys in Screen Tips - This option is available only when the Show Screen Tips
on toolbars is enable.

Large icons - Select this option to see the icons larger.

Normal icons  Large icons
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4.6 View - Panel Tabs

This menu shows all the options for displaying Panel Tabs.

4.6.1 View - Panel Tabs - Properties

This is the option to turn on/off the Properties panel tab.
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4.6.2 View - Panel Tabs - Layers Browser

This is the option to turn on/off the Layers Browser panel tab.

Use this tool bar to control what is displayed on your project. Each part of the tree can be expanded

by clicking on the plus  or collapsed by clicking on the minus 

Individual items or groups of items such as lines can be turned on/off by clicking on the eye 

4.6.3 View - Panel Tabs - Objects Browser

This is the option to turn on/off the Objects Browser panel tab.

Use this tool bar to control what is displayed on your project. Each part of the tree can be expanded

by clicking on the plus  or collapsed by clicking on the minus 

Individual items or groups of items such as lines can be turned on/off by clicking on the eye 
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4.6.4 View - Panel Tabs - Search Browser

This is the option to turn on/off the Search Browser panel tab.

If you press the button  some search parameters will appear

Object Type: This way you can select what kind of object you're looking for:
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Parameter: 

Imagine that your locking for one line that have a "3" in the name. In this case you do a search for:

Object type Lines and write "3" in the text box. Press the search button 

If you do a right click over one of those objects, it's possible to access its properties.
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4.6.5 View - Panel Tabs - Part Assessment

This is the option to turn on/off the Part Assessment panel tab.

The parts assessment allows to have real time consumptions.

Method: Several interlock costing techniques can be used;
There are several method:

Parts Area: The parts area;
Parts: The number of parts;
Parts Margin: Adds a margin in mm between parts;
Efficiency: Measure of efficiency, defined as material area being cut versus raw material area;
Result: Consumption area for the specified pattern.

The part preview window it's possible to drag and move the part, for a better view.
Use the middle mouse button to do that.
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4.6.5.1 Methods

Several interlock costing techniques can be used.

There are several method:

4.6.5.1.1  Convex Hull

This is a nesting interlock technique called Convex Hull.

It uses the tightest bounding convex polygon (Convex Hull) of the part or part group and evaluates the
resulting area.
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The result will be as displayed in the Part assessment panel tab, with the following result metrics: 

4.6.5.1.2  Parallelogram

This is a nesting interlock technique called Parallelogram. 

It uses the central point of the part group and packs, without any rotation, the group based on a
parallelogram that is the minimum parallelogram with the shortest height (distance in Y).

The result will be as displayed in the Part assessment panel tab, with the following result metrics: 
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4.6.5.1.3  Inverse Parallelogram

This is a nesting interlock technique called Inverse Parallelogram.

It uses the central point of the part group and packs, without any rotation, the group based on a
parallelogram that is the minimum parallelogram with the shortest height (distance in Y).

The result will be as displayed in the Part assessment panel tab, with the following result metrics: 
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4.6.5.1.4  Bounding box

This is a nesting interlock technique called Bounding Box.

It uses the tightest bounding box of the part group and evaluates the resulting area.

The result will be as displayed in the Part assessment panel tab, with the following result metrics: 
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4.6.5.1.5  Linear

This is a nesting interlock technique called Linear. This is used for linear raw materials automatically
fed from a roll.

It uses the minimum vertical linear strip that fully contains part group and evaluates the resulting
area.
The result will be as displayed in the Part assessment panel tab, with the following result metrics: 
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4.6.5.1.6  Circle

This is a nesting interlock technique called Circle.

It uses a calculated edge of the part group and evaluates, using a circle with a specific radius
traveling over that edge, the boolean union of all those circles.

After choosing the this technique enter the radius

The result will be as displayed in the Part assessment panel tab, with the following result metrics: 
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4.6.5.1.7  Grid

This is a nesting interlock technique called Grid. The system activate the grid over parts.

The operator add the grid value.

The result will be as displayed in the Part assessment panel tab, with the following result metrics: 
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4.6.5.1.8  Synthetic

This is a nesting interlock technique called Synthetic. This is used for synthetic materials available in
rectangular formats.

First the measures of the material should be defined.

The result will be as displayed in the Part assessment panel tab, with the following result metrics: 
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4.6.5.2 List

The tab List allows to group parts, delete consumptions studies and export then to CSV files.
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4.6.5.2.1  Edit a consumption study

1. Go to the List Tab.
2. Select the consumption to edit
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3. The information a will be as displayed in the Part assessment panel tab
4. Now its possible to change the parameters.
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4.6.5.2.2  Group Parts

1. Go to the List Tab.
2. Select the part to group, pressing the CTRL and click over the parts with the right mouse button.

3. Press the plus button , or do a left click and select Group.

4. The parts will be grouped.

5. Bellow it's possible to see the result, with the following result metrics: 



181View Overview

© 2016 Mind - Software Multimedia e Industrial, SA

6. Now its visible the Group Setting
Base Angle

Mode
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4.6.6 View - Panel Tabs - Paint Layers

This is the option to turn on/off the Paint Layers panel tab.

When we do a right click over the Layers area, the bellow menu appears.

Add - To create a new layer
Edit - To edit the selected layer
Clone - Copy the selected layer
Remove - Delete de selected layer

With different layers it's possible to select different intensities for each one.

4.6.6.1 Create New Layer

To create a New layer please follow the below explanation:

1. Select the option Add.

2. Enter the name of the new layer and press Ok.
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3. The new layer is added to the list.

4.6.6.2 How to use the Layers

At first you just have the layer Base, and everything you draw over the last stays at the same layer.

If you create a new layer.
This layer is automatically selected and everything you are now drawing is in the new layer. You can
see the blue line is in layer Base and the red line in the layer 1 that was just created.
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Note: To change between layers you just need to click  over it.

Now its possible to change the intensity of one layer without change the other one.
In the image below it's possible to see that we are changing the intensity of the layer 1 (red line) and
the Base layer didn't suffer any changes.

It's also possible to hide layers.
To do that you just need to uncheck them.
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As you can see the blue line that is in layer Base is now hidden.
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4.6.7 View - Panel Tabs - Paint Options

This is the option to turn on/off the Paint Options panel tab.

Line Style

H - Change this value to increase or decrease the hardness of the line.
T - Change this value to increase or decrease the line thickness.

Shape - There are several shapes available.
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Type - There are three different types of lines.

Ink Style

It's possible to paint with one colour or with one texture.

If you what to paint with texture select the button , to paint with colour select the button .

To change the colour/texture, click over the colour/texture, as shown in the below image.

The colour/texture library is shown. To select the new colour/texture just click over it and press Ok.
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4.6.8 View - Panel Tabs - Style Explorer

This option turns on/off the Style Explorer panel tab.

Catalogs are used to store the current project in different colour, material sole and accessory

combinations. These can be outputted to the viewer.

Auto preview - Select this box to automatically display any selected variants. It is recommended

that this is always selected.

Groups - To display the project in different colour/material combinations, the project must be divided

into groups of objects.

Variants - Each group can be saved with as many material combinations as required and later

combined to give variants (finished combinations for the whole project).
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4.7 View - Libraries

This menu allows to see all the available libraries for MindCAD 3D and hide/show them.

This menu shows all the options for displaying Libraries.

4.8 View - Status bar

This is the option to turn on/off the status toolbar. It is recommended that this menu is always

visible.
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4.9 View - Layers

This menu shows all the options for displaying layers.

4.9.1 View - Layers - Design

This is the option to turn on/off the design layer. This is the same as clicking the Design Mode

button  in the Layers toolbar.

The design layer is actually a combination of the other layers; it allows you to quickly set all the

required layers for designing.
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4.9.2 View - Layers - Preview

This is the option to turn on/off the preview layer. This is the same as clicking the Preview Mode

button  in the Layers toolbar.

The preview layer is actually a combination of the other layers; it allows you to quickly set all the

required layers to see a preview of the finished shoe.

4.9.3 View - Layers - Reference Helper Elements

This is the option to turn on/off the design helper lines and points layers.

Design helper lines are lines which are needed to give the designer more information about the last.

They normally are the central line of the last at the back and front, the feather edge and island

(around the top of the last) lines.

Design helper points are points that have been added at the digitizing stage, which have special

significance to the designer. These include vamp depth, back height, under ankle heights and so on.

Using the Design and Preview layer options means that under normal circumstances this option is

not required.

4.9.4 View - Layers - Upper Surface

This is the option to turn on/off the last upper surface layer. This is the same as clicking the Upper

Surface  button in the Layers toolbar.

4.9.5 View - Layers - Last bottom

This is the option to turn on/off the last bottom surface layer. This is the same as clicking the Last

Bottom  button in the Layers toolbar.
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4.9.6 View - Layers - Sole

This is the option to turn on/off the sole layer. This is the same as clicking the Sole  button in

the Layers toolbar.

4.9.7 View - Layers - Lines

This is the option to turn on/off different types of lines.

4.9.7.1 View - Layers - Lines - All Lines

This is the option to turn on/off all lines. This is the same as clicking the All Lines  button in

the Layers toolbar.

4.9.7.2 View - Layers - Lines - Style Lines

This is the option to turn on/off style lines.

4.9.7.3 View - Layers - Lines - Construction Lines

This is the option to turn on/off construction lines.
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4.9.7.4 View - Layers - Lines - Lining Lines

This is the option to turn on/off lining lines.

4.9.8 View - Layers - Parts

This is the option to turn on/off the parts layer. This is the same as clicking the Parts  button

in the Layers toolbar

4.9.9 View - Layers - Punches

This is the option to turn on/off the punches layer. This is the same as clicking the Preview 

button in the Layers toolbar

4.9.10 View - Layers - Stitches

This is the option to turn on/off the stitches layer. This is the same as clicking the Preview 

button in the Layers toolbar.

4.9.11 View - Layers - Accessories

This is the option to turn on/off the accessories layer. This is the same as clicking the Accessories

 button in the Layers toolbar.
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4.9.12 View - Layers - Pipes

This is the option to turn on/off the pipes layer. This is the same as clicking the Pipes  button

in the Layers toolbar.

4.9.13 View - Layers - Points

This is the option to turn on/off the points layers.

Points are positions on the surfaces with special significance, they will be specific to the current

last, and been added at the last digitizing stage. They include, vamp depth, back height, under ankle

heights and any others specified by the user when digitizing the last.

4.9.14 View - Layers - Text

This is the option to turn on/off the text layer. This is the same as clicking the Text  button in

the Layers toolbar

4.9.15 View - Layers - Markers

This is the option to turn on/off the markers layer.

Markers are points placed on the last surfaces in both 3D and 2D. They can be positioned when

using the measure options, they are displayed as red cones on the 3D surfaces and as green

crosses on the flattened surfaces.

4.9.16 View - Layers - Light Sources

This is the option to turn on/off the light sources layer.



195View Overview

© 2016 Mind - Software Multimedia e Industrial, SA

4.9.17 View - Layers - Stencils

This is the option to turn on/off the Stencil layer. This is the same as clicking the Stencils 

button in the Layers toolbar.

Stencils are images that can be loaded into the background. The last and the stencil image can be

scaled and moved to become aligned. The stencil can have its intensity changed so that the image

is displayed over the last. Lines can then be drawn onto the last to imitate the image.

The Stencils toolbar is displayed when the layer is turned on.

4.9.17.1 View - Layers - Stencils - List

This option lets you select any opened stencil.

Select the required stencil from the drop down list.

4.9.17.2 View - Layers - Stencils - Open

This option lets you open stencil.

This option will open a standard windows selection menu.

The stencil files can be of png, jpg, jpeg or bmp format.
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4.9.17.2.1  Stencils - Size and Position

To move and scale the stencil:

To move the stencil

1. Move the stencil by holding down the left mouse button on the stencil. Move the mouse to
drag the image.

2. Release the mouse button to complete the operation.

To scale the stencil

1. Scale the stencil by holding down the CTRL key and holding down the middle mouse button
on the stencil. Move the mouse to scale the image.

2. Release the mouse button to complete the operation.

To finish adjusting the size and position, right click and choose Finish.

When doing a right click anywhere on the screen the following options are available:

Finish: Store current view settings in the selected billboard.
Alignment wizard: Allows to align the stencil, using the help of a wizard.  
Adjust to window size: Will resize the image to match the current viewpoint, keeping the original
aspect ratio.
Adjust to image real size: Will return the image to its original size on screen.
Flip horizontal: Flip the image horizontally
Flip vertical: Flip the image vertically

4.9.17.2.1.1  Alignment w izard

Allows to align the stencil, using the help of a wizard.

1. Select the option Alignment Wizard from the contextual menu.
2. Pick the first alignment point on the last.
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3. Pick the second alignment point on the last.

4. Pick the first alignment point on the stencil.

5. Pick the last alignment point on the stencil. 
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6. As you click to select the last point, the stencil will be axiomatically adjusted to the last. 

4.9.17.3 View - Layers - Stencils - Delete

This option will delete the current stencil.
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4.9.17.4  View - Layers - Stencils - Grouping

This option, lets you group stencils.

This grouping allows you to view and control simultaneously all the stencils included within the same
group (set the transparency level, e.g.).

4.9.17.5 View - Layers - Stencils - Adjust

This option adjusts the transparency of the stencil.

Move the slider; the left side is less transparent, the right side is more transparent.

4.9.17.6 View - Layers - Stencils - Project Mode Stencil

This option project the texture over the last. 

When the option is selected the Texture Projection Dialog appears.
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Define the cutoff angle;
Select if you want to mirror the stencil;
Enable or disable the Edit Mode;
Fix or release the projection. 

4.9.17.6.1  Cutoff Angle

To enhance and control the quality of the 2D image projection in to the 3D last, especially on those
areas where the angle between the projection direction and the surface normal is high, you can use
the cutoff parameters - Start Cutoff Angle and End Cutoff Angle.

Cutoff is a term that refers to parameters that control the scope of the projected 2D image in the 3D
digital last, defining the projection regions where the image is blended with the surface.
Those cutoff values are defined as the angle between surface normal and projection direction. The
value of the cutoff changes as the angle between the vectors goes from 0 (vectors are parallel) to 90
degrees (vectors are perpendicular). 

Those cutoff values are defined as the angle between surface normal and projection direction. The
value of the cutoff changes as the angle between the vectors goes from 0 (vectors are parallel) to 90
degrees (vectors are perpendicular). 

The Start Cutoff Angle defines the angle from which the image starts to be blended, and the End
Cutoff Angle defines the angle where the blending stops.
Anything below Start Cutoff Angle if fully projected.  On the other hand, anything above End Cutoff
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Angle is not projected.

1. The selected image for projection appears on the workspace; the slider of the Texture Projection
Dialog window can be used to define the Start and End Cutoff angles.

2. Rotate the last to confirm the blending results

4.9.17.7 View - Layers - Stencils - Lock Last

Enable or Disable the Lock last option.
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If this option is on, the last will not move. 

4.9.17.8 View - Layers - Stencils - Refresh Stencils

Allows to refresh Stencils. 

4.9.17.9 View - Layers - Stencils - Close

This is the option to close the billboards toolbar.

4.10 View - Model Window

This lets you select the 3D window or pressing F3.

4.11 View - Upper Flattening

This lets you select the upper flattening window or pressing F2.
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If you click in the button Color lines according to their side position  in the constrain bar.

It's possible to see and identify what lines belong to inside, out site and both sides.
Medial + Lateral: 

Its possible to change between flattening, for that, select the drop drop menus:
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Full back:

Full front: 



205View Overview

© 2016 Mind - Software Multimedia e Industrial, SA

4.12 View - Insole Flattening

This lets you select the bottom flattening window or pressing F4.

4.13 View - Canvas Flattening

This lets you select the canvas flattening window. In this windows is just shown the painted parts in

the last.
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5 Components Overview

This menu allows to uptade, create and import components.

5.1 Components - Update

This options allows to update the last.

Update Last

Use this option to change the last used in a project. An interactive translation between flattening's
are provided to better control the final position of style lines.

This option can be used to update to a newer version of the same last, a completely different last, or
a last of the other foot (left or right).

5.2 Components - Create

This menu allows to create components
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5.2.1 Components - Create - Outsole

Use this option to create a sole, click over the desired one.

There are five sole types available:
Man Shoe
Lady Shoe
Wedge
Boxed (line based)
Sketch Based

5.2.1.1 Man Shoe

Use this option to create a Man Shoe sole. 

A set of parameters specific to this sole type must be provided using a wizard.
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1. Input thickness of sole (A).

2. Input length of heel (A) and front heel distance (B).
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3. Input wall thickness (A), welt width (B) and wall height (C) and finish the process.

4. The new sole, applied to the last is displayed. Sole in image is the result of the parameters

portrayed on the previous steps. 

5.2.1.2 Lady Shoe

Use this option to create a Lady Shoe sole.

A set of parameters specific to this sole type must be provided using a wizard.
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1. Input insole thickness (A), outsole thickness (B) and margin (C);

2. Input heel length (A), front heel distance (B);

3. The bottom profile could be controlled if "Define Bottom Line" is checked;

4. If "Define Bottom Line" is checked then a percentage of reduction from the top profile should be

input;
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5. Input cap piece height and finish the process.

6. The new sole, applied to the last is displayed. Sole in image is the result of the parameters

portrayed on the previous steps. 
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5.2.1.3 Wedge

Use this option to create a sole without a Wedge sole.

A set of parameters specific to this sole type must be provided using a wizard

1. Input sole thickness (A);

2. Input wall thickness (A), welt width (B) and wall height (C) and finish the process.
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3. The new sole, applied to the last is displayed. Sole in image is the result of the parameters

portrayed on the previous steps. 

5.2.1.4 Line Based

Use this option to create a line based sole (ie. a sole defined by a bite line and a set of parameters
similar to the "no heel" sole).
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Prior to the activation of this option for the creation of this type of sole, the following sequence is
necessary:
1. Draw a continuous bite line all over the last. To enable drawing of a single line crossing both sides

of the last activate the enable side crossing lines  tool.

2. Select the bite line

3. Choose the Components - Create - Outsole option and choose sole type "Line Based".
4. Enter Thickness of the Sole, Wall Thickness and ON/OFF Straight wall.

5. The new sole, applied to the last is displayed. Sole in image is the result of the parameters
portrayed on the previous steps. 
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5.2.1.5 Sketch Based

Use this option to create a sketch based sole.

The tool opens the drawing sketch plane.

1. Draw back line of the sole;

2. Draw front line of the sole;
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3. Draw the bottom line;

4. The top line is not necessary to generate the sole. It's optional.
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5. To generate the sole, do a right click and select Generate sole. (In this case we didn't draw the
top line.)

6. The sole is generated.
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7. To finish the sole do a right click and select finish.
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5.2.1.5.1  Edit Sketch based sole

To edit the current sole:

1. Select the sole, do a right click and select the option Edit Sole.

2. Select the line to be edited or do a right click and select the name of the line from the menu.
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a. Do a right click and select in the menu the line to edit;

b. In this case you have to draw a new back line;
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c. Do a right click and select the option Generate sole, to see the changes;

d. To change a line it's also possible to just select it and drag the points;
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e. Drag as many points as you wish;

f. When the line is in the desired position, do a right click and select generate sole;
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g. When your done editing the sole.
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5.2.1.5.2  Convert Sketch Sole

1. Select the sole.

2. Do a right click over it and select the option "Edit Sole Grid"

3. A windows asking if you really want to convert the sole to parametric is opened, click OK to
proceed.
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4. The conversion is made, now it's possible to edit the sole as a any other.

5.2.1.6 Outsole - Edit

To start Outsole edition:

1. Select the sole;

2. Do a right click;

3. Select the desired option.
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This toolbar will appear, it has necessary tools to edit parametric soles specific to MindCAD 3D
Design & Engineering

A short reference of the available functionality follows:

1.  - Select sole;

2.  - Recalculate sole (normal quality);

3.  - Recalculate sole (high quality);

4.  - Edit sole grid;

5.  - Edit bottom sole grid;

6.  - Add object to sole;

7.  - Remove object from sole;

8.  - Import object to sole;

9.  - Select edit surface;

10.  - Apply line operation to surface (voxel);

11.  - Apply line operation to surface (parametric);

12.  - Export lines (formats: 3t2, bgd, dxf, dgt, iges and pdf - preferencial bgd);

13.  - Import files (formats: 3t2, bgd, dxf, dgt, iges and pdf - preferencial bgd);

14.  - Save sole (external file - *.sole);

15.  - Close edit sole toolbar.

5.2.1.6.1  Edit Sole Grid

Use this option to edit the sole construction lines referred as a grid.

A sample editing sequence follows:

1. Select the sole surface to be edited.
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2. Do a right click over it, and select the option Edit sole grid or choose the option  in the
sole toolbar.

3. Select the line to edit and then the point to be moved;
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4. An editing plane appears. Others editing planes could be used simply by using the SPACEBAR
key.

5. If you want to turn off the auto-rotate camera to be able to freely move the edit plane, do a right
click and deselect the option Auto-rotate camera.
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6. Move the points or add/remove points using the SHIFT key while hovering on the selected line/
point. Adding a point will generate the corresponding section.

7. If the R key is pressed when adding a section, a linked reflected section is created automatically
created. To remove the dependency link between the sections, use right mouse click and choose 
Unlink Section.

8. To finish the editing process, activate the Recalculate Sole (normal or high quality)

 button on the Sole toolbar.
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5.2.1.6.2  Edit Bottom Sole Grid

Use this option to quickly edit the bottom sole grid. The process uses a helper clipper plane that
could be edited by profile sections.

A sample editing sequence follows:

Select the bottom sole surface.

Select Edit Bottom Sole Grid   button on the Sole toolbar. A reference clipper plane
appears.
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Select the line to edit and then the point to be moved. An editing plane appears. Others editing
planes could be used simply by using the SPACEBAR key.

Move the points or add/remove points using the SHIFT key while hovering on the selected line/point.
Adding a point will generate the corresponding section.

If the R key is pressed when adding a section, a linked reflected section is created automatically
created. To remove the dependency link between the sections, use right mouse click and choose 
Unlink Section.
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To finish the editing process, activate the Recalculate Sole (normal or high quality) 
button on the Sole toolbar.

5.2.1.6.3  Add Object to Sole

Use this option to add adjacent surface objects to the sole.

A sample editing sequence follows:

1. Select the sole surface where an adjacent surface object is to be added.
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2. Select the Add Object to Sole  button on the Sole toolbar.

3. This dialogue box will be displayed, pick the side and the thickness of the object to be added.

In this image we can see a sole to which was added one object above:



236 MindCAD 3D Design & Engineering

© 2016 Mind - Software Multimedia e Industrial, SA

 

4. To add another object to the sole do exactly the same thing:

This picture is shown the same sole that before, but with another object added in this case a below
object.
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Note: An extra adjacent surface object is added each time this option is used. All the sole objects
are adjusted to reflect the change.

5.2.1.6.4  Remove Object to Sole

Use this option to remove surface object from the sole.

A sample editing sequence follows:

Select the sole surface object to be removed.



238 MindCAD 3D Design & Engineering

© 2016 Mind - Software Multimedia e Industrial, SA

Select the Remove Object from Sole  button on the Sole toolbar. The surface object is
removed; all the sole objects are adjusted to reflect the change.

5.2.1.6.5  Import Object to Sole

Use this option to import an object to a sole. While importing it is possible to either replace or add
sole objects. 

A sample editing sequence follows:

Select the heel surface object.

Select the Import Object to Sole  button on the Sole toolbar

Select the file (*.sole) to be imported.
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Select objects to import, the Heel in this example and check the following entries:

Import grid: import the grid reference lines and sections associated with the surface.
Import base line: import the heel base line
Import surface objects: import surface child objects, those include lines or other objects that are
directly linked to the selected surface.
Import child objects: import dependent objects (ie. the top piece is a dependent object of the
heel)

Press OK and the heel is imported and adjusted to the current sole.
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5.2.1.6.6  Select Edit Surface

Use this option to select a surface for drawing operations.

A sample editing sequence over a surface is described:

Select the sole surface object.

Select the Select Edit Surface  button on the Sole toolbar

Now the sole surface is a drawing canvas where elements could be created and edited.

For drawing lines, select Lines on the Tools toolbar.
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To apply stitches to a line, please refer to Create - Stitches.

To create a pipe based on a line, please refer to Create - Pipe.

To create a text based on a line, please refer to Draw - Text.
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5.2.1.6.7  Apply line operation to surface (voxel)

Use this option to apply embossing doing direct manipulation of the triangle mesh using lines and
text as base shapes for carving or extruding paths.

A sample editing sequence using a text follows:
After creating a text over a surface, select the text and select the Apply line operation to surface

(voxel)  button. This will associate the carving/extruding tool with this text element. To remove
this association, you just have to select the Apply line operation to surface (voxel) button again
and no changes will be applied to the active sole surface.

Right mouse click and select Properties.
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On the Sole tab, mesh embossing parameters can be changed. Please change them as showed on
the previous pictures and press OK when finished.

A short reference on the available mesh embossing parameters follows:

Stroke
Width width of the stroke outline
Affect height map when enabled a carve/extrusion effect will be
created on the outline

Depth depth of carve/extrusion
Affect color map when enabled painting will be applied on the
outline

Color color of painting effect
Opacity opacity of painting effect

Tool Shape (cylinder, cone and sphere) tool shape to be used for the carve/extrude/
painting effect
Use different end values when enabled a value gradient will be used for the
aforementioned values

Width end value for the stroke outline width
Depth end value for the depth of carve/extrusion
Color end value for the color of painting effect
Opacity end value for the opacity of painting effect

Fill
Affect height map (none, solid, gradient and texture)

when enabled a carve/extrusion effect will be
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created on the inside
of the stroke based on one the options;

none: not enabled;
solid: fixed height;
gradient: variable height effect (ramp)
texture: height map based on texture

grayscale values
Depth

Final Depth depth of carve/extrusion
TEX transformation parameters for the texture if
applicable.

Angle rotation
Off X horizontal offset
Off Y vertical offset
Scale X horizontal scale
Scale Y vertical scale

Texture texture to be used
Repeat repeat pattern enabled
Revert invert grayscale values for height map

Affect color map (none, solid, gradient and texture)
when enabled painting will be applied on the inside
of the stroke based on one the options;

none: not enabled;
solid: a solid color;
gradient: color gradient
texture: use texture as a brush

Color color
Opacity opacity
Final Color end color for the gradient option
Final Opacity end opacity for the gradient option
TEX transformation parameters for the texture if
applicable

Angle rotation
Off X horizontal offset
Off Y vertical offset
Scale X horizontal scale
Scale Y vertical scale

Texture texture to be used
Repeat repeat pattern enabled

To quickly display the affected sole surface area use the Recalculate Sole (normal quality). For
an accurate display of the changes, use the Recalculate Sole (high quality) button.

The following picture displays the result of a Recalculate Sole (high quality) activation.
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5.2.1.6.8  Apply line operation to surface (parametric)

Use this option to apply embossing by direct creation and manipulation of simple child objects of the
active sole surface. This tool does not work with text elements.

A sample editing sequence using a line follows:
After creating a line over the surface, select the line and select the Apply line operation to surface

(parametric)  button. This will associate these tools with the selected line element. To
remove this association, you just have to select the Apply line operation to surface (parametric)
button again and no changes will be applied to the active sole surface

Right mouse click and select Properties.
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On the Sole tab, mesh embossing parameters can be changed. Please change them as showed on
the previous pictures and press OK when finished.

A short reference on the available mesh embossing parameters follows:

Stroke
o Width width of the stroke outline

o Depth depth of carve/extrusion

o Tool Shape (linear, rounded, inverse rounded)

tool shape to be used for the carve/extrude/
painting effect

To quickly display the effect of the added object to the sole surface area use the Recalculate Sole
(normal quality). For an accurate display of the changes, use the Recalculate Sole (high
quality) button.

The following picture displays the result of a Recalculate Sole (high quality) activation.
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5.2.1.6.9  Export Lines

Use this option to export lines. (formats: 3t2, bgd, dxf, dgt, iges and pdf - preferred format is bgd for
interchange between MindCAD suite applications) 

A sample editing sequence follows:

Select the sole surface object.

Activate the Export Lines  option.

Give a name to the export file (ie. test.bgd)

You could import this file into 2D Design & Engineering as a reference and add more geometric
elements. 
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Save the work into a bgd file again and import into 3D Design & Engineering. Please refer to Import
Lines for details.

5.2.1.6.10  Import Lines

Use this option to import lines. (formats: 3t2, bgd, dxf, dgt, iges and pdf - preferred format is bgd for
interchange between MindCAD suite applications) 

A sample editing sequence follows:

Select the sole surface object.

Activate the Import Lines  option.

Select the file to be imported, the lines will be added to the sole surface.
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5.2.1.6.11  Save Sole

Use this option to save the Sole object. The format .sole is a proprietary format with special
information that allows for total interchange between lasts.

A sample sequence follows:

Select the surface object. Although the selection is targeted at a single surface object, the save
operation will consider all the sole surface objects belonging to the same top level sole object.

Activate the Save Sole  and type the filename to be used to store the sole.

5.2.2 Components - Create - Accessory

This option opens the Accessory editor.

5.2.3 Components - Create - Stitch

This option opens the Stitch editor.

5.2.4 Componentes - Create - Editable Surface

This option allows to create editable surfaces, that can be placed accordingly to the user
preferences. 

1. Select Editable Surface from the menu Components - Create. The editable surface will appear. 
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2. The new surface can be moved to any location, click and drag in the green handles to move the
surface.

3. To Rotate the surface, do a right click and select Rotate from the contextual menu.

4. Just click and drag the dialer to the desired rotation, feedback of the angle is provided.

5. When the surface is corrected place, select finish from the contextual menu.
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6. To activate the surface edition, with the SIFT key pressed do a left click over the surface.
7. Now its possible to draw lines and create parts over the surface. 

5.3 Components - Extensions

This menu allows to add extensions to the last

5.3.1 Components- Extensions - Last

This menu allows to select the type of extensions

5.3.1.1 Components - Extensions - Last - Insole Extension

Use this option to control the activation and parameters of the Insole.

1. Select insole from tools menu.
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2. Doing a right click during the insole edition several options are available:

Finish - To finish the insole creation or editing.

Cancel - To cancel the insole creation or editing.

Remove Insole - To remove the insole.

By Measures - To create the insole based on measures. Two dialogs will be displayed to insert the
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values: 

a. Insert the Front values:

b. Insert the Back values:

Insole Type:

Straight - this option makes the insole straight.

Follow Tangent - this option makes the insole follow the tangent of the last surface.

Adjust Lengths - To adjust the length of the points.
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Adjust Directions - To adjust the direction of the points.

3. Do a right click and select Finish. The result will be:



255Components Overview

© 2016 Mind - Software Multimedia e Industrial, SA

5.3.1.2 Components - Extensions - Last - Welt Extension

Use this option to control the activation and parameters of the midsole.

On the Tools menu select the Midsole option. A dialog will appear and input the following values

A midsole is created based on user values. 
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5.4 Components - Import

Use this option to load a component into the current project. Two types of components:

Those generated in 3D Design & Engineering that are adaptable to any last and are reconstructed
after loading.

Static geometry that should be previously adapted to the target last on an external package and
exported to supported file formats.
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6 Draw Overview

This option shows all the options for drawing.
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6.1 Lines Properties

Select the line, do a right click and select Properties.
The below panel tab will appear.

In this panel allows to change the line name, layer, type, offset, thickness, color and side. It's
also possible to smooth line and select if the line is supposed to synchronize with 2D system.

6.2 Draw - Curve Line

This is the same as clicking the Curve line  button in the Tools toolbar.
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Use this option to draw lines in both 3D and 2D. By default the lines will be curved, but corners can
be added at any time. For the purposes of this documentation the examples will be done in 3D as
this is the more common situation.

This tool allows to draw closed line, curve line, polyline, polygon and sketch lines.

Example 1 - Curved line

1. Select Curve Line from the Draw Menu. The cursor will be displayed as a cross.

2. Insert points on the last using the left mouse button

3. To finish the line either double click the left mouse button or press the right mouse button and
select finish from the menu

Example 2 - Curved line with corner

1. Select Curve Line from the Draw Menu. The cursor will be displayed as a cross.
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2. Insert points on the last using the left mouse button.

3. To add a corner either press ctrl as you add the point or when the cursor is in the correct position
for the point, press the right mouse button and select add corner from the menu

.

4. Continue drawing the line and finish as in example 1.
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5. The corner option can be used repeatedly in any line to create a zigzag effect.

Example 3 - Closed line

1. Select Curve Line from the Draw Menu. The cursor will be displayed as a cross.

2. Insert points on the last using the left mouse button.

3. When the cursor approaches the first point of the line, the two points join.

4. To finish the line either double click the left mouse button or press the right mouse button and

select finish from the menu.

5. And the result will be a closed line.
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Example 4 - Sketch Line

1. Select Curve Line from the Draw Menu. The cursor will be displayed as a cross.

2. the start of the line (which must be on the last surface), hold down the left mouse button and move
the cursor across the last surface.

Many points will be added to the line.

3. Release the left mouse button. The number of points will be automatically reduced and the line
finished.
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Tips
In curse lines use as few points as you can to create it.
Avoid drawing across the cone and heel center lines if possible, as these lines will not be give the
desired result when 'mirrored'
Use the snap functions in the constrain menu to keep lines (points) accurate.
Use both 3D and 2D windows.

6.2.1 Add to adjacent surface

1. Click in the Curve line  button. The cursor will be displayed as a cross.

2. Insert points on the last using the left mouse button.

3. When the line is in the boundary with other surface, like the image below,
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4. Do a right click and select the option Continue on adjacent surface, in this case the adjacent
surface is the last Bottom.

5. Select the option Bottom, and continue to draw the line, now in the last bottom.

6. After finish the line.
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7. Now its possible to create parts that cross surfaces based on this type of lines.

6.2.2 Line editing - Move point

1. Select the button Select from the Tools toolbar. The cursor will be displayed

.

2. Select the line to be edited. As you approach a point on the selected line the cursor will change to
a pen.
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3. Press and hold down the left mouse button, as you move the mouse the point will move. To finish
the edit release the left mouse button.

4. Repeat on any point on the selected line.

6.2.3 Line editing - Adjust height

Use this option to change the line height easily. Please see lifter lines.
 

1. Select the button Select from the Tools toolbar. The cursor will be displayed

2. Select the line to be edited.

3. Press the right mouse button and select the Adjust Height option from the menu.
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4. As you approach a point on the selected line the cursor will change to a pen.

5. Press and hold down the left mouse button, as you move the mouse the point will move. To stop
the edit release the left mouse button.
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6. Repeat on any point on the selected line.

7. To finish press the right mouse button and select the Finish option from the menu.



270 MindCAD 3D Design & Engineering

© 2016 Mind - Software Multimedia e Industrial, SA

6.2.4 Line editing - Add/Delete point

To add a point to a line.

1. Select the button Select from the Tools toolbar. The cursor will be displayed

.

2. Select the line to be edited.

3. Hold down the shift button, approach the selected line between original points, the cursor will

change to a pen with a plus sign ( ).

4. Press the left mouse button to add a point at this position.

To delete a point from a line.

1. Select Object selection from the Selection options on the Tools menu. The cursor will be
displayed.

.

2. Select the line to be edited.

3. Hold down the shift button, approach the point to be deleted, the cursor will change to a pen with a

minus sign ( ).

4. Press the left mouse button to delete the point.

6.2.5 Line editing - Changing a Corner/Curve point

To change the corner/curve property of a point,

1. Select the button Select from the Tools toolbar. The cursor will be displayed.

2. Select the line to be edited.

3. Approach the point to be edited and get the pen cursor displayed.
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4. Press the right mouse button and select the Change corner/curve option from the menu.

5. After changing the curve to corner:

To change the corner/curve property of many points at once,
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1. Select the button Select from the Tools toolbar. The cursor will be displayed.

2. Select the line to be edited.

3. With SHIFT pressed draw one shape around the desired points.

4. Approach one of the points to be edited and get the pen cursor displayed.

5. Press the right mouse button and select the Change corner/curve option from the menu.
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6. After changing the points:

6.2.6 Line editing - Dragging/Scaling/Rotating lines

Note: The option Edit control points Only must be disable.

1. Select the button Select from the Tools toolbar. The cursor will be displayed

2. Select the line(s) to be edited. With the pointed cursor displayed .

3. Press the left mouse button and hold it down to drag the lines.
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4. Press the Ctrl button and the middle mouse button to scale the lines with the cursor.

5. Press the Ctrl button and the right mouse button to select the rotation point. Then press the left
mouse button to start rotation. Move the cursor to rotate the line(s) and another press of the left
mouse button will complete the operation.

For further information see Drag Constrain.

6.3 Draw - Bezier

This is the same as clicking the Bezier line  button in the Tools toolbar.

With this type of line it's possible to have better control the direction of tangents to each of the
control points of the line.

1. Select Bezier Line from the Draw Menu. The cursor will be displayed as a cross.

2. Insert points on the last using the left mouse button, by default the simple point will be corner
points.

3.  To control the point tangent during the line creation, press down the left mouse button and move
de mouse until have the desired curvature.
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4.  To finish the line either double click the left mouse button or press the right mouse button and
select finish from the menu

6.3.1 Bezier Line Editing

1. Select the button Select from the Tools toolbar. The cursor will be displayed

.

2. Select the line to be edited. As you approach a point on the selected line the cursor will change to
a pen.
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3. Press and hold down the left mouse button, as you move the mouse the point tangent will move.

4. Hold down the Shift key and hold down the left mouse button, as you move the mouse the
direction of tangents will match.
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5. Hold down the Shift+Ctrl key and hold down the left mouse button, as you move the mouse. You
can see that now its possible to change one side length without interfering with the length of the
other side. 

6. Repeat on any point on the selected line.

6.4 Draw - Sawtooth line

Use this option to draw sawtooth lines (zigzag lines) in both 3D and 2D.

1. Select Sawtooth Line from the Draw menu. The cursor will be displayed as a cross.

2. Insert points on the last using the left mouse button.
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3. To finish the line either double click the left mouse button or press the right mouse button and
select Finish from the menu

To change the size or type of sawtooth.

1. Select the line.

2. Press the right mouse button and select the Properties option from the menu.
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3. Select the Sawtooth Line tab in the dialogue box.
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4. Use the options to select the type, format and size of sawtooth required. The shape and size of
the selected options will be displayed in the Preview window.

6.5 Draw - Circle

This option lets you to draw circles or ovals.

1. Select Circle from the Draw menu.  The cursor will be displayed as a cross.
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2. Insert a point on the last using the left mouse button. Move the mouse to give the diagonally
opposite corner of circle/oval and press the left mouse button again to complete the operation.

.

This option also lets you to draw ovals

3. To insert the measures of the circle/ovals press the right mouse button and select by Measures.

4. Insert the Width.

5. Select OK.

6. Insert the Height and press OK
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7. Select OK.

8. Now every time you click in the last one circle will appear.

6.6 Draw - Rectangle

This option lets you to draw rectangles.

1. Select Rectangle from the Draw menu.  The cursor will be displayed as a cross.

.

2. Insert a point on the last using the left mouse button. Move the mouse to give the diagonally
opposite corner of rectangle and press the left mouse button again to complete the operation.
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3. To insert the measures of the rectangles press the right mouse button and select by Measures.

4. Insert the Width.

5. Select OK.

6. Insert the Height and press OK
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7. Select OK.

8. Now every time you click in the last one rectangle will appear.

6.7 Draw - Text

Use this option to create text.

1. Select the line(s).

2. Select Text on the Create menu.

3. Select Text, properties (right mouse button) and choose the properties.

- Text (write the text)
- Font
- Height
- Bold
- Italic
- Revert
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6.8 Draw - Continue line

This option lets you add points to the ends of lines.

1. Select Continue line from the Draw menu. The cursor will be displayed as a cross

As you approach the end of a line the end will highlight
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2. You can now add points to the end of the line using the left mouse button, finish the edit by double
clicking the left mouse button, or use the finish option in the menu displayed by clicking the right
mouse button.

6.9 Draw - Extend

This allows any selected line(s) to be extended (made longer)

1. Select line(s) to be extended

2. Select Extend from the Draw menu and right click (select by value or by point). 

3. If by value, select Set Value and a dialogue box will be displayed. Enter the value required for
the extension and select OK.

The line(s) will be extended by the required value, the extension is done by adding extra nodes to
each end of the line(s) selected
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4. If by point, select one end of line and drag the point to the required extension value.

6.10 Draw - Split Line

This allows any selected line to be split (cut) at any point.

This is the same as clicking the split  button in the Tools toolbar.

1. Select the line to be split.

2. Select Split line from the Draw menu.

As the cursor is moved to the line the cursor will change to a pair of scissors

3. Split the line by clicking the left mouse button at the required position.
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6.11 Draw - Join Lines

This allow to join two lines.
1. Select the first line (point to join).
2. Select the second line (point to join).
3. Select Join line from the Draw menu.
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7 Tools Overview

This menu lets you carry out all selection operations, draw lines, lift objects and change their
thickness, measure on screen, align sole with a last and use real time rotation to display your shoe
dynamically.

7.1 Tools - Links On/Off

This option lets you keep a reference to the original line or not.

This is the same as clicking the Links  button in the Tools toolbar

If Links are ON when a line is created by mirroring or offsetting, any future edits of the original line,
will be reflected in the linked lines as well.

If Links is OFF when an operation is carried out, the newly created line is independent.

7.2 Tools - Corner

Use this option to create a corner. This is mainly to control the corners shape of parts.

Two major interactions are possible with corners: creation and modification.

Creation
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1. Choose Create Corner  on the Tools menu.

2. Select the lines, when you select the last line, the corner will be created.

3. right click and the contextual menu appears

4. use Change corner type to:
Arc
Bezier
Chamfer

5. use Change radius... and input the required value

6. use Finish to finalize

7. use Finish and continue to finalize the corner and do another one.

Modification

1. select the corner element and choose Edit Corner on the Operations menu.

2. right click and the contextual menu appears
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3. use Change corner type to:
Arc
Bezier
Chamfer

4. use Change radius... and input the required value

5. use Finish to finalize

6. use Finish and continue to finalize the corner and do another one.

7.3 Tools - Perpendicular

This allows you to draw a style line perpendicular to another.

1. Select the line you wish to construct the perpendicular line from.

2. Select Perpendicular  from the Tools menu. A dot will be displayed on the original style line.

3. Select the start point for the new line by clicking the left mouse button.

4. Move the mouse to control the length and direction of the new line.

5. Finish the new line by clicking the left mouse button

7.4 Tools - Offset

This shows all the options for offset lines.
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7.4.1 Tools - Offset - Offset

Use this option to create an offset line from a selected line.

This is the same as clicking the Offset  button in the Tools toolbar.

A sample editing sequence follows:

1. Select the line to be offset, select Offset from the Offset options of the Tools menu. A dialog will
appear requesting an offset value:

2. Press OK.
3. To create the offset line, give the direction for the offset by doing a left mouse click, on the left or

right side of selected line.
4. The offset will appear.
5. The values for the offset can be changed.

Two red lines drawn between the original line and the newly offset line show that the input value is
applied at both ends of the line.

You can move the green dot by moving the mouse, clicking the left mouse button will allow you to
enter a new value at that point.

If you move the green dot over an existing value it will turn red
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To terminate the edition, select Finish from the menu displayed by clicking the right mouse button.

Change Side -  Use this option to change the direction of an offset from its original line.

Change distance - To change the distance of an offset from its original line.

Change to single distance – allows you to change a complex offset with multiple values to a

simple offset with one value.

Remove offset parameter – use this when the offset dot is red to delete an offset parameter.

Free offset line – breaks the offset dependency and release the slave line for editing.

7.4.1.1 Tools - Offset- Change distance

To change the distance of an offset from its original line.

1. Select the offset line.

2. Do a right click and select Edit offset dependency.
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3. Do other right click and select Change distance.

A menu will be displayed
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4. Select an individual value to be changed and enter a new value, to change the offset on an
individual point, or enter the new value and use the all option to change the offset on the whole
line.

5. Select OK

7.4.2 Tools - Offset - Multiple Offset

Use this option to create several offset lines from a selected line.

Number of offsets - Enter the number of offsets.

Distance - To define the distance between the offsets you can choose one of the following methods:
Fixed - Insert the distance between the offsets.
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Variable - Insert the start and end distance.
Mouse Defined - The mouse click will define the offsets distance.

7.4.3 Tools - Offset - Edit offset

This option allows to o edit the Offset parameters.

This is the same as doing a left click over the offset line and selecting Edit offset line. 

Now the values for the offset can be changed.

Two red lines drawn between the original line and the newly offset line show that the input value is
applied at both ends of the line

You can move the green dot by moving the mouse, clicking the left mouse button will allow you to
enter a new value at that point.
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If you move the green dot over an existing value it will turn red

Clicking the left mouse button while the dot is red will allow you to change the existing value or
using the Remove offset parameter option will remove the offset at that point.

7.4.4 Tools - Offset - Edit multiple offsets

This allows to o edit the Multiple Offset parameters:

1. In alternative you can select one of the lines, offsets or the main line and do a right click over it.

2. Select Edit multiple offset dependencies, from the contextual menu. 
3. The Multiple offsets window will appear, do the required changes and press Apply. When finished,
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press Close. 

7.4.5 Tools - Offset - Free offset

This option allows to break the offset dependency and release the slave line for editing.

7.4.6 Tools - Offset- Repeat

To repeat an offsetting operation on multiple lines.

1. After doing an offset operation on a line, select a new line.

2. Select Repeat from the Offset options of the Tools menu, or press F5

3. Give the direction of the offset by clicking the left mouse button.

4. Select Finish from the menu displayed by clicking the right mouse button.

5. Repeat on as many lines as required.
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7.5 Tools - Mirror

This allows you to mirror or reflect lines either to the other side of the shoe or about an axis.

7.5.1 Tools - Mirror - Over front line

This allows any selected line(s) to be mirrored over front line.

This is the same as clicking the Mirror Over front line button  in the Tools toolbar or

pressing CTRL+M.

1. Select line(s) to be mirrored.

2. Select Mirror – Over front line from the Tools menu.

7.5.2 Tools - Mirror - Over heel line

This allows any selected line(s) to be mirrored to over heel line.

1. Select line(s) to be mirrored.

2. Select Mirror – Over heel Line from the Tools menu.

7.5.3 Tools - Mirror - Over Axis

This allows any selected line(s) to be mirrored over an axis.

1. Select line(s) to be mirrored.

2. Select Over axis from the Mirror options of the Tools menu.

3. Select the line (axis) to be mirrored across.

The lines will be mirrored about the axis and the axis will be displayed as a dotted line for future
mirroring operations.



301Tools Overview

© 2016 Mind - Software Multimedia e Industrial, SA

7.6 Tools - Measurements

These options let you take measurements between points on the last and along any lines. Can
pressing Ctrl+K for free option.

7.6.1 Tools - Measurements - Free

This tool take measurements over the last surface without being restricted to lines.

A sample sequence follows

Select Free from the Measurements options of the Tools menu. Select a point on the last, using
the left mouse button.
As you move the cursor the distance from the first point will be displayed.

Click the left mouse button again to finish the operation.

While measuring, doing a right click the following options are available:

This is when the 3D Measure option is selected
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This is when the 2D Measure option is selected
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Finish - Finalize the measurement operation.
Straight Line - Measures the straight distance between two points. 
Set Value - Enter set measurement value.
2D Measure - 2D Measure operation.
3D Measure - 3D Measure operation.
Select another line - only available when doing measurements over a line.
Start line from here - enables the curve drawing tool, starting a line from the measure end point.
Place marker here - place a marker at the measure end point.
Place markers at start and finish - place markers at both ends of the measure line.

7.6.2 Tools - Measurements - Line

This tool take measurements over along a line.

A sample sequence follows:

Select a line, select Line from the Measurements options of the Tools menu point on the last,
using the left mouse button select a point over the line to start measuring.

As you move the cursor the distance from the first point will be displayed and the measuring path
highlighted.
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Click the left mouse button again to finish the operation.

While measuring, doing a right click the following options are available:

This is when the 3D Measure option is selected

 

This is when the 2D Measure option is selected
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Finish - Finalize the measurement operation.
Straight Line - Measures the straight distance between two points.
On the surface - Measures the distance between two points along the surface.
Set Value - Enter set measurement value.
2D Measure - 2D Measure operation.
3D Measure - 3D Measure operation.
Select another line - selects another line for measuring operation.
Start line from here - enables the curve drawing tool, starting a line from the measure end point.
Place marker here - place a marker at the measure end point.
Place markers at start and finish - place markers at both ends of the measure line.





Part

VIII
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8 Create Overview

This menu allows to create pipes, laces, stitches, Accessories.

8.1 Create - Pipe

This allows any selected line(s) to have a pipe element displayed based on line orientation.

Pipes are shapes which can be round, triangular or square and can be used to represent laces, for

example.

The pipes created in this manner can be offset from the surface (if required) to become part of the

finished shoe. The geometry of the pipe is always calculated from the original line, so to change the

shape of a pipe you must edit the original line.

8.1.1 Create - Pipe - Simple

A Pipe Simple is a revolution element that follows exactly over the master line.

1. Select line(s) to be made into pipes.

2. Select Pipes/Simple from the Create menu. 
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3. Select the Section, Thickness, Revolution angles and Sections.

Section

Triangular - Give the pipe a triangular shape

Square - Give the pipe a square shape

Round - Give the pipe a round shape

n-Side - user defined number of sides

From puncher - this is automatically checked if there was a drag operation of punch shape
over the pipe. In this case the pipe will use the punch shape as a template for its cross section. 

Thickness

Height - Change the height (away from the last surface) of the pipe

Wide - Change the width (along the last surface) of the pipe

Revolution Angle - A pipe does not have to have a full 360 degree surface. Change this value to

make the surface smaller. The following example shows that a revolution angle produces a 'half' pipe

shape.

Sections

Number of Sections - The number of parts that the pipe will be divided

Spacing - The space in mm between the sections, i.e, transitions between the pipe

sections.
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4. Press Ok and the new pipe will be displayed. 

5. Now its possible to select each section, or more that one and edit them in different ways.

8.1.1.1 Pipe Simple - Editing

To change the material,

1. With the pipe selected, go to the Materials library and select the material, it will be added to the
selected objects. Or drag the material from the Materials library and drop on to the pipe

2. Use the texture selection tool to change the materials scale and position.

To change the pipe type,

1. Select the pipe section.
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2. Right click the mouse to display the pop-up menu.

Note: If you what to change the properties the entire pipe, first you need to select the option Select
All Components, otherwise the changes will be applied just to the selected section.

3. Select Properties, to display the Properties dialogue box.

4. Modify the pipe parameters as required.
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Sections
Select the section to edit.

To add a new section press the button  and do a mouse click over the desired pipe extremity.

To delete a section, select the section and press the button .

Section

Triangular - Give the pipe a triangular shape

Square - Give the pipe a square shape

Round - Give the pipe a round shape

n-Side - user defined number of sides

From puncher - this is automatically checked if there was a drag operation of punch shape
over the pipe. In this case the pipe will use the punch shape as a template for its cross section. 
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Height - Change the height (away from the last surface) of the pipe

Wide - Change the width (along the last surface) of the pipe

Revolution Angle - A pipe does not have to have a full 360 degree surface. Change this value to

make the surface smaller. The following example shows that a revolution angle produces a 'half' pipe

shape.

Rotation Angle - If the pipe has a revolution angle of less than 360 degrees the surface can be

rotated, using this value. A rotation angle of 90 degrees rotates the pipe as shown below.

Adjust on top of parts - On or Off adjust on top of parts.
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Independent offset - This allow for a more flexible positioning process of pipes without losing their
dependency with constructive design lines, i.e, if this options is selected it's possible to change the
pipe height without changing interfering with the line parameters. 

8.1.1.1.1  Sections and Translations

When a pipe is created its possible to add as many section as desired.

The sections will be divided by translations, each transition can have the desired length.

It's possible to edit each section in a different way, the transitions will do the best connection
possible between the different pipe sections.

In order to do that select the desired pipe section by clicking over it or in the properties panel. 

Now it's possible to change the selected pipe section
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It's also possible to change the transitions length, in order to do that, its possible to click and drag
the transition handles, or change the Length value in transition tab visible in the properties panel.

To add a new transition press the button  and do a mouse click over the pipe in the desired
place. 
(Note: it´s not possible to add to transitions side by side)

To delete a transition, select the transition and press the button .

8.1.2 Create - Pipe - Spiral

A Pipe Spiral is a revolution element that circles around the master line with a specific period and
amplitude.

1. Select line(s) to be made into pipes.

2. Select Pipes/Spiral from the Create menu.
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3. Insert the Period, Thickness, Radius, Angle fase and select Ok.

The new spiral pipe will be displayed. It can then be selected for editing if required

8.1.2.1 Pipe Spiral - Editing

To change the material,

1. With the pipe selected, go to the Materials library and select the material, it will be added to the
selected objects. Or drag the material from the Materials library and drop on to the pipe

2. Use the texture selection tool to change the materials scale and position.

To change the settings pipe spiral,
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1. Select the pipe.

2. Right click the mouse to display the pop-up menu.

3. Select Properties, to display the Properties dialogue box.

If you prefer to see the spiral pipe image, do a right click and select the option Edit Spiral.
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4. Modify the pipe parameters as required.

Section

Period - Period of spiral

            Radius - Radius of spiral

            Thickness - Thickness of spiral

            Angle fase - Angle of spiral

            Reverse angle 

8.2 Create - Lace

With this option the operator can create laces, either by defining each lace segment between two

anchor points or by applying a lace template to a pair of aligned reference elements like accessories

or punches.

To enable the Lace tool there are several options

select Create option from Lace under Create menu
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picking a lace and select Edit option from Lace under Operations menu
picking a lace and choosing Edit Lace on the right click menu while in the Select tool

When in this Lace tool, the right click menu contains the following options

Create New Create new lace
Edit Edit lace
Apply template By selection of two accessories or punch groups creation of automatic laces

will happen.
Select All Laces, None or invert selection
Base Height Increase or Decrease Base Height 
Height Increase or Decrease Height 
Pipe Wide Increase or Decrease Pipe Wide
Pipe Height Increase or Decrease Pipe Height
Type Select Type (Above, Below, Above then Below and Below then Above)
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Finish Finish process

8.2.1 Create - Lace - Create

To create a lace group with several segments the operator should do as follows:

1. select Create option from Lace under Create menu

Note: if you are going to use reference elements like punches and/or accessories, please ensure
you having the appropriate combination of visible layers

2. select the first pivot point where the lace segment starts.

Note: it is not mandatory to select a pivot point based on pre defined elements, they could be placed
anywhere but the operator will only get snap information over the special elements like accessories
and punches.

3. select the second pivot point where the lace segment ends.
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4. repeat steps 2 and 3 to create more lace segments. The process will not finish until the operator
chooses Edit or Finish on the right click menu.
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5. the lace segment will be displayed over the geometry
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8.2.2 Create - Lace - Create from Template

To create a lace group using a predefined lace pattern the operator should do as follows

1. Select Create from template option from Lace under Create menu

Note: if you are going to use reference elements like punches and/or accessories, please ensure
you having the appropriate combination of visible layers

2. Right click and select Apply template.

3. Select two punch distribution groups or two distribution accessory groups.

4. Select the required Lace pattern template.
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Lug Lace - When this option is tick the laces will stay on the surface, this option is used for support
laces with eyelets for sports shoes. For more detailed information please go to Lace - Editing - Lug
Lace.

5. After selection the lace pattern is created and editing could be done.
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8.2.3 Lace - Editing

Lace editing is possible by selecting the lace and choosing Edit Lace on the right click menu while
in the Select tool.

Note: Besides the normal laces editing method, the laces can be edited like pipes.

The Lace toolbar appears and editing of the lace could be done:

On this toolbar the following options are available:

Increase base height

Decrease base height 
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-
Increase height

Decrease height

Increase center height

Decrease center height

Increase pipe wide

Decrease pipe wide

Increase pipe height

Decrease pipe height

The same options appear on the right click menu
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Besides having the functionality to select any other lace while in this mode, there are also options
under the Select submenu to select all laces and revert selection.

with the exception of Type. Using the shortcut "T" to cycle between lace segment types will give the
following combinations:
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Above

Below
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Above then Below

Below then Above  
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8.2.3.1 Lace - Editing - Lug Lace

This option is used for support laces with eyelets for sports shoes. 

1. Select Create option from Lace under Operations menu
2. Right click and select Apply template.
3. Select the distribution accessory groups.

4. Select the option Lug Lace and the required Lace pattern template.

5. The lug lace option will be applied to the selected template.
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6. There are three different types of lug lace. To see it do a right click over the lace when the Lace
edition is activated and select Direction.

Lug - Lug option
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Lug - Normal option

Normal - Lug option

8.3 Create - Stitches

This allows to add stitches to lines and WeltExtensions
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8.3.1 Create - Stitches - Along Line

This allows any selected line(s) to have a new line of stitches displayed over them. The stitch lines

created in this manner can be offset from the surface (if required) to become part of the finished

shoe. The geometry of the stitch lines is always calculated from the original line, so to change the

shape of a stitch line you must edit the original line.

1. Select the line(s) to be made into new stitch lines.

2. Select the stitch shape required by clicking on it in the left mouse button.

3. Select Along line from Stitches option on the Create menu.

The new stitch lines will be displayed. They can then be selected for editing if required.

8.3.2 Create - Stitches - Stitchdown

Use this option to control the Stitch Down operation. This is only possible when a Welt Extension
is enabled, please refer to Welt Extension section for details.

On the Create menu select the Stitch Down from the Stitches options. 

Create Stitch Down

Select the Create option. A dialog will appear and input the following values, in this case simply the
distance from the edge.
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A stitch line is created based on distance and current selected stitch.

Edit Stitch Down

Select the stitches, do a right click over it and select Edit Stitch down option. 
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While hovering on the stitch line information about its parameters is displayed. 

Doing a right click while over the stitch line several options are available. 
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A short reference of options and actions:
Finish - will finalize the edit sequence.
Create - enters the Create Stitch Down sequence as described above.
Delete - delete the stitch line.
Distance from edge ... - change distance from edge.
Start from heel - the stitch line starts at heel point, this is selected by default.
Start from toe - the stitch line starts at toe point.
Finish at heel - the stitch line ends at heel point, this is selected by default.
Finish at toe - the stitch line ends at toe point, this is selected by default.
Stitching properties - regular Stitch Line properties, please refer to Stitch Line Properties section.

It is possible to control the start and end point location by simply dragging the end points to the
desired locations.

The stitch line now starts at 35 mm from heel point.
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8.3.3 Create - Stitches - Properties

Use this option to change stitches properties.

1. Select the stitch, clicking the right mouse button and select properties.

The original stitches will be:
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2. Select the Spacing (mm). 

3. Select the Angle of Offset (deg.). 
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4. Select the Scaling. Tick the uniform scaling option to keep the tree values equals. 

a) Along displacement
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b) Across displacement

c) Along surface normal

5. Enable or disable Automatic adjust objects on top of parts 
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6. When the option is enable its possible to refresh it by doing a right click over the stitches and

select Refresh. 

8.3.4 Stitch Library

The operations possible over this library are similar to others with the exception of a proprietary editor
for this type of elements. 
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Nevertheless, functionality to use generic geometry created inside MindCAD 3D Design &
Engineering and store as a new stitch template is possible. Please refer to File - Import - Stitch for
details.

8.3.4.1 Stitch Library - Stitches - New

This option opens the Stitch editor.

8.3.4.2 Stitch Library - Stitches - Import

Use this option to import Stitches, from file or selection. Please refer to File - Import - Stitches for

details.

8.3.4.3 Stitch Library - Stitches - Edit

This option opens the Stitch editor, allowing to edit the current stitch. 

8.3.4.4 Stitch Library - Stitches - Delete

This option delete the currently selected stitch. You can do multiple selection using the Ctrl as
modifier.

8.3.4.5 Stitch Library - Stitches - Rename

It's possible to rename Stitches in the Library by:

1. Select the stitch, do a right click over it and select Rename.
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It's also possible to rename stitches already placed by:

1. Select the stitches, do a right click and select properties.

2. Select Properties.

3. Select the Generic tab.
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4. Now it's possible to type a new name in the text box or get one from the Names Library

5. To select the Names Library click in the "+"

6. It's possible to create new names, delete the existing ones or select one of the already created
in the library.
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8.3.4.6 Stitch Library - Stitches - Cut

This option cut the currently selected stitch. You can do multiple selection using the Ctrl as
modifier.

8.3.4.7 Stitch Library - Stitches - Copy

This option copy the currently selected stitch. You can do multiple selection using the Ctrl as
modifier.

8.3.4.8 Stitch Library - Stitches - Paste

This option paste the stitch clipboard buffer (filled by cut or copy) into the library

8.3.4.9 Stitch Library - Stitches - Select All

This option Select all stitches of the library.

8.3.4.10 Stitch Library - Stitches - Select Owners

This option allows to see where the selected stitch is used in the current model.

8.4 Create - Accessories

This option lets you add accessories to your design for extra realism. Accessories are 3 dimensional
objects modelled in several ways:

1. External generic surface editor (ie. Autodesk 3DS Max, Autodesk Maya to name a few)

2. Inside MindCAD 3D Design & Engineering own accessory editor.

3. Created from selected part geometry from within MindCAD 3D Design & Engineering

They include eyelets, badges and any other accessory. There are several displacement options for
Accessories.

8.4.1 How do I add a single accessory to a shoe?

The required sequence to attain this objective follows:

1. Select an accessory from the decorations bar by clicking the left mouse button, keep the button
pressed down.
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2. Move the mouse to place the accessory on the surface, and release the left mouse button. When
the accessory is selected with the left mouse button it can be moved, scaled and rotated using
the normal commands for these operations.

Move - Move the mouse and the lines will move with the cursor.

Scale - Click the left mouse button twice, when the second click is made the lines will start
to scale with the movement of the mouse

Rotate - The first click of the left mouse button will define the rotation point. The second click
will start the rotation of the lines. A third click will position the lines.

8.4.2 Create - Accessories - By number

This option equally spaces the current accessory along the current line.

1. Select the line(s).

2. Select an accessory by clicking on it with the left mouse button.

3. Select Along Line from the Accessories options on the Create menu.

A dialogue box will be displayed.

4. Enter the number of accessories required and OK.

Another dialogue box will be displayed.
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5. Enter the distance along the line to the first and last accessory (normally zero) and click OK.

The accessories will be displayed equally spaced along the selected line(s).

8.4.3 Create - Accessories - By distance

This option spaces the current accessory along the current line at a fixed distance.

1. Select the line(s).

2. Select an accessory by clicking on it with the left mouse button
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3. Select Along Line from the Accessories options on the Create menu.

A dialogue box will be displayed

4. Enter the distance required between accessories and OK

Another dialogue box will be displayed

5. Enter the distance along the line to the first and last accessory (normally zero) and click OK

The accessories will be displayed spaced at the required distance from the start of the line(s)
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8.4.4 Create - Accessories - Multiple Lines

This option multiple lines accessory along the current line at a fixed distance.

1. Select a line that has accessories spaced along it (any method).

2. Select an accessory by clicking on it with the left mouse button

 

3. Select Along Line from the Accessories options on the Create menu.

A dialogue box will be displayed

4. Enter the Number of lines under Multiple lines
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5. There is also the possibility of entering the distance to the first line separation and final line
separation accessory

After pressing OK the accessories will be displayed spaced at the required distance from the start of
the line(s)
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8.4.5 Create - Accessories - Copy/paste

This option allows to copy accessories.

1. Select a placed accessory or accessories displacement.

2. Do a right click over the accessories.
3. In the contextual menu, select Copy.

4. Do a right click and in the contextual menu select Paste.
5. The accessory will be pasted over the original. 
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8.4.6 Create - Accessories - Automatic adjust objects on top of parts

This option adjust objects on top of parts. Sometimes when the accessories are placed they stay

below the parts.

1. Select the accessories that are spaced along a line (any method). and do a right click over the
accessories and select Properties option.

2. Choose the tab Displacement Properties. 
3. By checking Automatic adjust objects on top of parts, the accessories are placed on the

surface of the underlying parts (the default behaviour is for them to be placed to a certain height
from the surface of the last)
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4. Click in the Apply button and all the accessories are placed adjusted to the parts as depicted
below.
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5. After select the option one time, every time you need to adjust the accessories on top of the parts
again, just select the accessories do a right click and select Refresh.

8.4.7 Create - Accessories - Change number of items

This option is used to edit the number of accessories spaced long a line(s).

1. Select a line that has accessories spaced along it (any method).
2. Do a right click over the accessories and select Properties option.

3. Choose the tab Displacement Properties. 
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4. Enter the required number of accessories and click in the Apply button.

The required number of accessories will be displayed equally spaced along the line(s).

8.4.8 Create - Accessories - Change spacing

This option is used to change the spacing of accessories spaced long a line(s).

1. Select a line that has accessories spaced along it (any method).
2. Do a right click over the accessories and select Properties option.
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3. Choose the tab Displacement Properties. 

4. Enter the required between the accessories and click in the Apply button.

The accessories will be displayed, spaced along the line(s) at the new distance between them.
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8.4.9 Create - Accessories - Change distance to first accessory

This option is used to change the distance to the first accessory on a line that has already had
accessories spaced on it.

1. Select a line that has accessories spaced along it (any method).
2. Do a right click over the accessories and select Properties option.

3. Choose the tab Displacement Properties. 
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4. Enter the distance required to the first accessory and click in the Apply button.

The accessories will be re-spaced with the new distance to the first accessory.

8.4.10 Create - Accessories - Change distance to master line

This option is used to change the distance to the first accessory on a line that has already had
accessories spaced on it.

1. Select a line that has accessories spaced along it (any method).
2. Do a right click over the accessories and select Properties option.



359Create Overview

© 2016 Mind - Software Multimedia e Industrial, SA

3. Choose the tab Displacement Properties. 

4. Enter the distance required to master line accessories and click in the Apply button.

The accessories will be re-spaced with the new distance to the master line.
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8.4.11 Create - Accessories - Change multiple lines

This option is used to change the distance to the first accessory on a line that has already had
accessories spaced on it.

1. Select a line that has accessories spaced along it (any method).
2. Do a right click over the accessories and select Properties option.

3. Choose the tab Displacement Properties. 
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4. There is also the possibility of entering the distance to the first line separation and final line
separation accessory

The accessories will be displaced along multiple parallel lines based on the parameters entered
above.

8.4.12 Accessories Library

To invoke the accessories editor do a right click on the Accessories library 

and either choose New... or Edit if hovering an accessory. 
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Only accessories created inside MindCAD 3D Design & Engineering could be modified by this
editor.

Many other options are available on the context of an accessory, please refer to child sections from
this topic for details.

The concept of creating an accessory is exactly the same when creating design elements over the
last surface. Almost all the drawing tools and operations are enabled while editing inside this editor,
being all of them applied to a plane helper surface acting as a reference drawing board.

You are creating a reusable element with the additional flexibility of modification when necessary
instead of relying on an external editor to do the job.
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8.4.12.1 Accessories - New

Use this option to create new accessories.

Right click on the accessories toolbar, select New..., this will open the accessories editor.

The accessory editor opens. Please refer to Accessories - Edit for editing details. 

8.4.12.2 Accessories - Import

Use this option to import accessories. Please refer to File - Import - Accessory

8.4.12.3 Accessories - Edit

This option is used to edit accessories. Please note, only accessories created inside MindCAD 3D

Design & Engineering could be modified by this editor.

A sample editing sequence follows:

1. While hovering an accessory, right click and select Edit. (only enabled for built inside) 
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2. To control the dimension of the work place do a right click over it and select Canvas dimension.

Insert canvas Width and Height:

3. Drawing an accessory using the 3D drawing tools and some operations tools (or import dxf, hpgl...
format).
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4. Next we create a part, holes, padding and punches.
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5. Then we make changes to material and geometry (offset, thickness, ...) properties available on the
3D.

6. for better visualization we can move, scale, rotate the working plane like we do with the last on the
main window of MindCAD 3D Design & Engineering. Modification of layer visibility is also possible
for final design evaluation.
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7. a very important step is defining the pivot axis to be used when placing this accessory on last
surface. Please note that the pivot point is always the center of the helper drawing surface defined by
the intersection of the two major grid lines. To do that you have the following choices under 
Orientation menu option.

Normal - pivot axis is perpendicular to helper plane (ie. the accessory is placed as showed on the
last surface)
Rotated 90º Up - Pivot axis is vertical going upwards over the major vertical grid line.
Rotated 90º Down - Pivot axis is vertical going downwards over the major vertical grid line.
Rotated 90º Left - Pivot axis is horizontal going left over the major vertical grid line.
Rotated 90º Right - Pivot axis is horizontal going right over the major vertical grid line.
Define Orientation - This allows to interactively define the pivot and displacement axis, please refer
to Accessories - Edit - Orientation for details.

8. under File menu there are the following options:

Close and save - saves the accessory on the accessory library, closes the editor and returns to
main window
Close without saving - just closes the editor and returns to main window. All the work done is lost.
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8.4.12.3.1  Acessories - Edit - Orientation

This option is used to define accessories orientation.

This allow to define pivot axis (red) and displacement axis (green) associated with a certain
accessory. Those axis are used as references when placing the accessory over the last surface.
Please note that the pivot point is always the center of the helper drawing surface defined by the
intersection of the two major grid lines. To do that you have the following choices in the Edit menu
under Orientation options.

Normal - pivot axis is perpendicular to helper plane (ie. the accessory is placed as showed on the
last surface)

     

Rotated 90º Up - Pivot axis is vertical going upwards over the major vertical grid line.
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Rotated 90º Down - Pivot axis is vertical going downwards over the major vertical grid line.

   

Rotated 90º Left - Pivot axis is horizontal going left over the major vertical grid line.
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Rotated 90º Right - Pivot axis is horizontal going right over the major vertical grid line.

   

Define Orientation - by controlling directly the axis, the operator could adjust to an arbitrary
position. The axis could be edited independent from each other. However, when selecting any other
of the aforementioned choices, these custom angles are lost.
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There is also the possibility to directly rotate the accessory over the surface last, please refer to Edit
- Transform - Constrained Rotation for details.

8.4.12.4 Accessories - Delete

This option deletes the currently selected accessories. You can do multiple selection using the Ctrl

as modifier.

8.4.12.5 Accessories - Rename

It's possible to rename accessories in the Accessories Library by:

1. Select the accessory, do a right click and select Rename.



372 MindCAD 3D Design & Engineering

© 2016 Mind - Software Multimedia e Industrial, SA

It's also possible to rename a accessory already placed by:

1. Select the accessory, do a right click and select properties.

2. Select Properties.

3. Select the Generic tab.
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4. Now it's possible to type a new name in the text box or get one from the Names Library

5. To select the Names Library click in the "+"

6. It's possible to create new names, delete the existing ones or select one of the already created
in the library.
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8.4.12.6 Accessories - Cut

This option cut the currently selected accessories. You can do multiple selection using the Ctrl as

modifier.

8.4.12.7 Accessories - Copy

This option copy the currently selected accessories. You can do multiple selection using the Ctrl as

modifier.

8.4.12.8 Accessories - Paste

This option paste the accessories of the accessory clipboard buffer (filled by cut or copy) into the

library.

8.4.12.9 Accessories - Select All

This option Select all accessories of the library.
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9 Parts Overview

This menu lets you create parts and add holes, padding, punch holes and stitching to the parts.

It also lets you create lifter lines that allow you bend portions of parts. 

These are useful when you want to do something such as threading a buckle.

Advanced features like simulation of material deformation is possible by the creation of wrinkles.

9.1 Parts - Create Part

This menu allows you to select if you what to create a part by contour or by merging.

9.1.1 Parts - Create Part - By Contour

This is the same as clicking the Create part  button in the Parts toolbar or pressing Ctrl+T.
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1. Select Create Part from the Parts Menu. The design will be displayed in drawing mode.

While creating a new part, other parts are also visible but in phantom mode. 

The operator can control the transparency level by choosing the Set transparency level option on
the right click menu.

2. Start to define the boundary of the part.
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3. Continue to select lines going in the same direction. The direction is not important as long as
within each part you move in the same direction.
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4. Using the right mouse button, select Finish Part to complete the part.

The part will be highlighted.



380 MindCAD 3D Design & Engineering

© 2016 Mind - Software Multimedia e Industrial, SA

Cancel Part - Use this to cancel the part creation operation.

Remove Last Selected - If you make a mistake when selecting a line, use this option to undo the
last selection. You can then pick another line.

Remove All - Remove all the selected lines and start the part definition process again.

9.1.1.1 Parts - Create Part - Auto Bootie

1. Draw a line that crosses sides. 

2. Select Create Part from the Parts Menu. The design will be displayed in drawing mode.
3. Select the line.
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4. Do a right click and select the option Finish Auto Bootie

5. The part will be created using the last bottom line. This will be a part created over the last surface.
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9.1.1.2 Parts - Create Part - Auto Liner

1. Draw a line that crosses sides. 

2. Select Create Part from the Parts Menu. The design will be displayed in drawing mode.
3. Select the line.

4. Do a right click and select the option Finish Auto Liner



383Parts Overview

© 2016 Mind - Software Multimedia e Industrial, SA

5. One part will be created using the last bottom line. This will be a part created inside the last
surface.
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9.1.2 Parts - Create Part - By Merging

This option allows to merge two parts into one.

1. In the image below we have two separated parts.

2. To merge the parts, select the option By Merging Parts from Create Parts in the Parts menu. 

3. Now select the parts to merge. Click over the first part to select it.

4. Select the second part to merge.
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5. With both parts selected, do a right click and select Finish from the contextual menu.

6. A warning will appear, asking if the original parts should be deleted or not. Select Yes to delete
the original parts, No to keep them. 

7. The edges of both parts will be stitched forming just one part.

Note: Is available to merge, already merged parts. 



386 MindCAD 3D Design & Engineering

© 2016 Mind - Software Multimedia e Industrial, SA

9.1.3 Parts - Create Part - By Merging Top Level Surfaces

This option allows to create parts based on top level surfaces merging.

1. Deactivate every surface edition. 
2. With the edition surface deactivated, its possible to select the Top Level Surfaces.
3. Select the desired Top Level Surfaces.

4. Select the option By Merging Top Level Surfaces from Create Parts in the Parts menu. 

The part will be created involving the selected top level surfaces.

9.2 Parts - Holes

This option lets you apply holes to parts, the holes can be defined from primitives (lines) or from
punches.

9.2.1 Parts - Holes - By Contour

This is the same as clicking the Apply hole to part  button in the Parts toolbar.
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1. Select the part to have a hole.

2. Select from contour from the Holes options on the Parts Menu. The design will be displayed in
drawing mode.

3. Start to define the boundary of the hole.

4. Continue to select lines going in the same direction. The direction is not important as long as it is
the same, within each hole.
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5. Click the right mouse button and select finish hole to complete the part.
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The part will be drawn with the hole.

9.2.2 Parts - Holes - By Punches

This is the same as clicking the Apply punch to part  button in the Parts toolbar.

1. Select the part to have holes.

2. Select from punches from the Holes options of the Parts menu. The design will be displayed
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showing only punches.

3. Select the punches to be applied to the part.

4. Click the right mouse button and select Finish punches to complete the part.

The part will be drawn with the punches applied as holes.
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9.2.2.1 Apply Punches at multiple parts

1. Select the parts to have holes.

2. Select from punches from the Holes options of the Parts menu. The design will be displayed
showing only punches.

3. Select the punches to be applied to the part.
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4. Click the right mouse button and select Finish punches to complete the parts.

The parts will be drawn with the punches applied as holes.
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9.3 Parts - Stitches

This is the same as clicking the Apply stitches to part  button in the Parts toolbar.

1. Select the part to have stitches applied.

2. Select the stitch required using the Stitches Library.

3. Select On Edge from Stitches options in the Parts menu.

A menu will be displayed and also the part boundary.
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4. Choose the sections of the part boundary to have stitches by selecting the option boxes. As each
option is selected the corresponding section of the part boundary will be highlighted.
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Use the Distance (mm) option to select the complete boundary or to clear your selection.

5. When the selection is complete, set the distance from the boundary for the stitches in one of the
following ways:

§ Use the CTRL to select the sections of the part boundary and enter a value.

6. Use Apply to show the stitches with offsets.
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7. Apply up to 4 rows of stitches using Stitch line No. drop down list.

8. Select Finish. The part will be displayed with the stitches applied.
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9.3.1 Create Stitch Lines on Holes

To create stitches lines on holes, the operator should do as follows:

1. Select the part.

2. Move the cursor over the edge of he hole until highlighted.
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3. Right click the mouse to display the pop-up menu.

4. Select Apply stitches to part.
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9.4 Parts - Deformers

This menu allows to apply deformers to the parts.

9.4.1 Parts - Deformers - Padding

This is the same as clicking the Apply padding to part  button in the Parts toolbar or

pressing Ctrl+R.

1. Select the part to have padding applied.

2. Select Padding from the Deformers options in the Parts menu. The design will be displayed in
drawing mode.

3. Start to define the boundary of the padding. It could be the same as the boundary of the part.

4. Continue to select lines going in the same direction. The direction is not important as long as it is
the same, within each padded area.
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5. Click the right mouse button and select Finish Padding to complete the padding.
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6. Use the options on the dialogue box to select the type of padding that is required.

Sides



402 MindCAD 3D Design & Engineering

© 2016 Mind - Software Multimedia e Industrial, SA

Both sides parallel - The inside of the part will be kept parallel with the outside

Both sides symmetric - The inside of the part will be padded in the opposite direction to the
outside, good for padded collars.

Outside only - Pad the outside of the part and leave the inside flat

Inside only - Pad the inside of the part and leave the outside flat

Parameters - Use the radio buttons to select the shape of the padding

Left value - The distance from the lines selected to define the padding that you wish the
padding to start.

Center value - Only applies to the lower option - the distance between the start of the
padding and the full depth of padding. A small value gives a steep edge and a large value a shallower
edge.

Right value - The depth of the padding

Edge sharpness - Allows to have a better control over lifters edges, by setting different values for
Top and Bottom edge sharpness. 

Top - Refers to the top edge
Bottom - Control the bottom edge
Note: The higher the value, more angular the edge will be.

Surface properties

Padder combination

 the highest padder will be used to deform the part on regions with multiple
padders
 the lowest padder will be used to deform the part on regions with multiple
padders 
 all the padders will be taken in account by summing its individual height
contributions.

7. Enter values to define the distances shown by the graphics.

8. Select OK. The part will be drawn with the padding applied.
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9.4.1.1 Parts - Mixing Padders

1. Select the part that has the padders applied and the respective padder.

2. Do a right click and select Properties or Edit Padder.

3. If you select Edit Padder option the below dialogue box will be displayed.
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4. If you select Properties option, select the padder tab 
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5. Change the Padder combination option to:

a) Top most and press Ok.
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b) Cumulative and press Ok.

c) Bottom most and press Ok.
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Top most  the highest padder will be used to deform the part on regions with multiple padders
Bottom most  the lowest padder will be used to deform the part on regions with multiple padders 
Cumulative  all the padders will be taken in account by summing its individual height

contributions.
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9.4.1.2 Parts - Add Auto Padding Full part

This option allows to add a padding to a full part automatically.

1. Select the part to apply the padding.

2. Click the right mouse button and select Finish Padding (full part) to complete the padding.

3. Use the options on the dialogue box to select the type of padding that is required.
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4. Press ok and de padding will be applied to the full part.
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9.4.2 Parts - Deformers - Lifters

This option lets you lift an area of a part relative to a line. It can be used to create a lifted area around

the center of a buckle.

1. Select the part to have a lifter applied, and the line being used as the lifter line.

2. Select Lifters from Deformers option in the Parts menu. A dialogue box will be displayed.
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3. Set the values required for the dimensions displayed in the graphics and the edge sharpness (the
higher the value, more angular the edge will be).

4. Select OK. The line will be highlighted but the part will not.
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5. To lift the line, select Increment from the Lifters option in the Tools menu. Repeat this until the
required lift has been achieved. Alternatively you can assign an increment value on the lifter edit
box or adjust the line height. 

6. If you add a buckle, the resulting design would look like this:

When multiple lifters are applied to a certain part, there is the option to control how they interfere
with each other. To control this, the available options are under Lifter Combination 

For farther information please refer to Parts - Mixing Lifter Lines.

Top most  the highest lifter will be used to deform the part on regions with multiple lifters
Bottom most  the lowest lifter will be used to deform the part on regions with multiple lifters 
Cumulative  all the lifters will be taken in account by summing its individual height contributions.
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9.4.2.1 Parts - Mixing Lifter Lines

1. Select the part to have the lifters applied, and the lines being used as the lifters lines.

2. Select Lifters from Deformers option in the Parts menu. A dialogue box will be displayed.
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3. Set the values required for the dimensions displayed in the graphics.

4. Change the Lifter combination option to:

a) Top most and press Ok.

To lift the lines, select Increment from the Lifters option in the Tools menu.
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b) Cumulative and press Ok.
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c) Bottom most and press Ok.

In this case makes more sense to decrease the line height.

Top most  the highest lifter will be used to deform the part on regions with multiple lifters
Bottom most  the lowest lifter will be used to deform the part on regions with multiple lifters 
Cumulative  all the lifters will be taken in account by summing its individual height contributions.
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9.4.2.2 Parts - Sides

There are different types of lifters. To change the type off lifter:

1. Select the part to have a lifter applied, and the line being used as the lifter line.

2. Select Lifters from Deformers option in the Parts menu. A dialogue box will be displayed.
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3. Change the Sides option, the Both sides parallel is the usual option.
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4. Option Both sides symmetric.
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5. Option Outside only.
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6. Option Inside only.
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9.4.3 Parts - Deformers - Wrinkle

This tool is able create a wrinkle effect
 
1. select the part and control line to have the wrinkle applied.
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 A dialogue box will be displayed.
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2. set the following parameters of this tool to the desired values. From top to bottom:

Displacement
By Number: number of periods of the effect.
By Distance:

[S] Wrinkle distance from initial edge: period length at the start of the wrinkle
effect (defined by the dashed control line).
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[M] Central wrinkle distance: period length at the middle of the wrinkle effect.
[E] Wrinkle distance from final edge: period length at the end of the wrinkle

effect.

Common Parameters
[A] Wrinkle height: height of the wrinkle effect.
Attenuation along line: decay of the Amplitude (A) along the dashed control line

(No attenuation, Linear, Quadric, Logarithmic, Exponential and
Gaussian).

Length Attenuation: decay of the Length parameters (L1, L2) along the dashed control line
(No attenuation, Linear, Quadric, Logarithmic, Exponential and

Gaussian).

Side Parameters
[L1] Wrinkle distance: distance of affectation along L1.
[L1] Wrinkle attenuation: decay of the Amplitude (A) along L1

(No attenuation, Linear, Quadric, Logarithmic, Exponential and
Gaussian).

[L2] Wrinkle distance: distance of affectation along L2.
[L2] Wrinkle attenuation: decay of the Amplitude (A) along L2

(No attenuation, Linear, Quadric, Logarithmic, Exponential and
Gaussian).
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3. after confirmation the wrinkle effect is applied to the part.

4. multiple applications of this wrinkle tool are possible, the following example is on a strap. 
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9.5 Parts - Replace Line

This option will enable the operator to replace a line on a part.

1. select the part and a design line that was used as the basis for the edge to be changed. (use
CTRL to select both)
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2. select the new line to be used as the new edge.
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There are some constrains on the lines that are suitable for replacement. The target line should be
positioned against all others belonging to the edges, keeping the topology very similar. Pattern of
new intersections will have to be very similar to the original intersection pattern.
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9.6 Parts - Properties

To edit the properties of existing parts,

1. Select the part

2. Right click and select Properties from the pop-up menu.

A panel tab will be displayed with the following tabs:

Generic

Material

Edge
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9.6.1 Editing properties - Generic

Select this tab to edit the Generic properties of the part.

Identification:

Name - Use the drop down list to change the name or type in a name.

Layers - Use this to select the part layer. 

Positioning: 

Offset (mm) - The offset of the part from the last surface - can be changed by using the up or down
arrows.

Thickness (mm) - The thickness of the part - can be changed by using the up or down arrows.
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Scale - Only applies to accessories and punches.

Angle - Only applies to accessories and punches.

Quality:

Surface quality (1-10) - Choose the surface quality between 1 and 10. 

Remesh - Select to have an uniform triangles distribution. 

Connection:

Synchronize with 2D system - Select if you what to synchronize with MindCAD 2D or not.
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9.6.2 Editing properties - Material

Use this tab to edit the properties of the material of the part.

Select the material side you want to work on:

To change the material, click over the folder icon 

Select the material from materials library.
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9.6.3 Editing properties - Edge

 The properties of the selected edge of the part.

If the edge of the part is selected, you can modify the properties of the edge by selecting the Edge

tab.
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Apply to all edges on this part - Use this if the part selected has multiple edges (holes in the part).

If selected any edits done to one of the edges will be applied to all the other edges.

Type:

Straight edge - Give the part a flat edge between inner and outer surfaces.

Round edge - Give the part a round edge between inner and outer surfaces. If the part is made

thicker or thinner the rounded edge adjusts automatically to the new parameters.

Arc down edge - Give the part an arc down edge between inner and outer surfaces.

Arc up edge - Give the part an arc up edge between inner and outer surfaces

Chanfer down - Give the part a straight down edge between inner and outer surfaces.

Chanfer up - Give the part a straight up edge between inner and outer surfaces.

Options:

Outer edge on style lines - Allows to synchronize the edge with the boundary line, to ensure the

part never exceeds the construction lines, regardless the edge type.

Keep same slop- Allows to synchronize the edge boundary offset with the thickness of the part, to

maintain the edge proportions – if you change the thickness, the boundary will follow according the

defined Boundary Offset.
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10 Paint Overview

This option shows all the options for painting.

10.1 Paint - Brush

This is the same as clicking the Brush  button in the Paint Last toolbar.

Use this option to freely paint lines on the last, that have a different appearance and texture. To
customize the brush go to View - Panel Tabs - Paint Options
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10.2 Paint - Flood Fill

This is the same as clicking the Flood Fill  button in the Paint Last toolbar.

To customize the flood fill go to View - Panel Tabs - Paint Options

This tools fill the active or visible layers with color. 

1. Select the area to be painted.

2. Select the Flood Fill tool and click in the area to be painted.

10.3 Paint - Eraser

This is the same as clicking the Eraser  button in the Paint Last toolbar.

To customize the eraser go to View - Panel Tabs - Paint Options
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Use this tool to erase painted areas.

10.4 Paint - Clone Area

This is the same as clicking the Clone Area  button in the Paint Last toolbar.

To select the area to be cloned press down Shift when the mouse is over the desired area.

After selecting the area to clone, let go of the Shift key and start painting.
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Continue to clone and paint areas until you have the desired result.

10.5 Paint - Mirror

This menu allows to mirror the painted areas.

10.5.1 Paint - Mirror - Auto Mirror

The Auto Mirror tool enables you to turn symmetry on and off as you sketch. Anything drawn on
one side of the axis of the shoe last will be mirrored.

Enable/ disable the  icon in the Paint Last toolbar, or select/deselect it on Paint menu.
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10.5.2 Paint - Mirror - Mirror

The Mirror on Demand window choose how you want to make the mirroring: from inside to outside
or outside to inside. Choose the layer you want to mirror and the desired Opacity.
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10.6 Paint - Decal

On Surface

This is the same as clicking the Texture Projection  button in the Paint Last toolbar.

10.7 Paint - Curve Line

This is the same as clicking the Curve Line  button in the Paint Last toolbar.
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11 Masks Overview

This menu allows to create drawing restrictions or select draw areas.

11.1 Masks - Rectangle

This is the same as clicking the Rectangle Mask  button in the Masking toolbar.

11.2 Masks - Free Hand

This is the same as clicking the Free Hand Mask  button in the Masking toolbar.

11.3 Masks - Polygon

This is the same as clicking the Polygon Mask  button in the Masking toolbar.
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11.4 Masks - Magic Wand

This is the same as clicking the Magic Wand Mask  button in the Masking toolbar.

11.5 Masks - Delete

This options allows to Delete the create drawing restrictions or select draw areas.

11.6 Masks - Select None

This options allows to deselect all masks.
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12 Style Overview

This menu intends to add all the steps to a design process.

12.1 Style - Load Style Lines

This option allows to import lines. Those lines are projected to the last surface.

12.1.1 Style - Load Style Lines - from IGES

Use this option to import an IGES file with style lines. Those lines are projected to the last surface.

12.1.2 Style - Load Style Lines - from 2D file

Use this option to import lines from other software packages
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12.1.2.1 Style - Load Style Lines - from 2D file - BGD

Use this option to import lines from MindCAD 2D Design & Engineering.

1. Select BGD from 2D file options of Load Style References on the Style menu.

2. Select the file containing the geometry and click Open.

The lines will be imported and highlighted.

3. Use the right mouse button pop-up menu to manipulate the lines.

Finish - Add the imported lines to the flattening

Cancel - Abandon the operation

Move - Move the mouse and the lines will move with the cursor.
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Scale - Click the left mouse button twice, when the second click is made the lines will start
to scale with the movement of the mouse

Rotate - The first click of the left mouse button will define the rotation point. The second click
will start the rotation of the lines. A third click will position the lines.

Flip Horizontal - Flip the geometry about the vertical axis

Flip Vertical - Flip the geometry about the horizontal axis

12.1.2.2 Style - Load Style Lines - from 2D file - DGT

Use this option to import lines in DGT format.

1. Select DGT from 2D file options of Load Style References on the Style menu.

2. Select the file containing the geometry and click Open.

The lines will be imported and highlighted.

3. Use the right mouse button pop-up menu to manipulate the lines.



453Style Overview

© 2016 Mind - Software Multimedia e Industrial, SA

Finish - Add the imported lines to the flattening

Cancel - Abandon the operation

Move - Move the mouse and the lines will move with the cursor.

Scale - Click the left mouse button twice, when the second click is made the lines will start
to scale with the movement of the mouse

Rotate - The first click of the left mouse button will define the rotation point. The second click
will start the rotation of the lines. A third click will position the lines.

Flip Horizontal - Flip the geometry about the vertical axis

Flip Vertical - Flip the geometry about the horizontal axis

12.1.2.3 Style - Load Style Lines - from 2D file - DXF

Use this option to import lines in DXF format.

1. Select DXF from 2D file options of Load Style References on the Style menu.

2. Select the file containing the geometry and click Open.
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3. Use the right mouse button pop-up menu to manipulate the lines.

Finish - Add the imported lines to the flattening

Cancel - Abandon the operation

Move - Move the mouse and the lines will move with the cursor.

Scale - Click the left mouse button twice, when the second click is made the lines will start
to scale with the movement of the mouse

Rotate - The first click of the left mouse button will define the rotation point. The second click
will start the rotation of the lines. A third click will position the lines.

Flip Horizontal - Flip the geometry about the vertical axis
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Flip Vertical - Flip the geometry about the horizontal axis

12.1.2.4 Style - Load Style Lines - from 2D file - HPGL

Use this option to import lines in HPGL format.

1. Select HPGL from 2D file options of Load Style References on the Style menu.

2. Select the file containing the geometry and click Open.

The lines will be imported and highlighted.

3. Use the right mouse button pop-up menu to manipulate the lines.

Finish - Add the imported lines to the flattening
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Cancel - Abandon the operation

Move - Move the mouse and the lines will move with the cursor.

Scale - Click the left mouse button twice, when the second click is made the lines will start
to scale with the movement of the mouse

Rotate - The first click of the left mouse button will define the rotation point. The second click
will start the rotation of the lines. A third click will position the lines.

Flip Horizontal - Flip the geometry about the vertical axis

Flip Vertical - Flip the geometry about the horizontal axis

12.1.2.5 Style - Load Style Lines - from 2D file - ISO

Use this option to import lines in ISO format.

1. Select ISO from 2D file options of Load Style References on the Style menu.

2. Select the file containing the geometry and click Open.

The lines will be imported and highlighted.

3. Use the right mouse button pop-up menu to manipulate the lines.
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Finish - Add the imported lines to the flattening

Cancel - Abandon the operation

Move - Move the mouse and the lines will move with the cursor.

Scale - Click the left mouse button twice, when the second click is made the lines will start
to scale with the movement of the mouse

Rotate - The first click of the left mouse button will define the rotation point. The second click
will start the rotation of the lines. A third click will position the lines.

Flip Horizontal - Flip the geometry about the vertical axis

Flip Vertical - Flip the geometry about the horizontal axis

12.1.2.6 Style - Load Style Lines - from 2D file - PDF

Use this option to import lines in PDF format.

1. Select PDF from 2D file options of Load Style References on the Style menu.

2. Select the file containing the geometry and click Open.
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The lines will be imported and highlighted.

3. Use the right mouse button pop-up menu to manipulate the lines.

Finish - Add the imported lines to the flattening

Cancel - Abandon the operation

Move - Move the mouse and the lines will move with the cursor.

Scale - Click the left mouse button twice, when the second click is made the lines will start
to scale with the movement of the mouse

Rotate - The first click of the left mouse button will define the rotation point. The second click
will start the rotation of the lines. A third click will position the lines.
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Flip Horizontal - Flip the geometry about the vertical axis

Flip Vertical - Flip the geometry about the horizontal axis

12.2 Style - Load Stencil Reference

This option lets you open stencil.

1. Select the image, and click open.

 For further information please refer to View - Layers - Stencils
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12.2.1 Style - Load Stencil Reference - 3D Stencil

1. Select the stencil to open

2. The 3D Stencil will be added.

3. Now it's possible to manipulate the stencil as any 3D object, by rotate, move, scale.

To access this option, select Edit Stencil position  from stencils toolbar. 
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12.3 Style - Decal Stencil Reference

This option project the texture over the last. 
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12.4 Style - Style Explorer

This option turns on/off the Style Explorer panel tab.

Catalogues are used to store the current project in different colour, material sole and accessory

combinations. These can be outputted to the viewer.

Auto preview - Select this box to automatically display any selected variants. It is recommended

that this is always selected.

Groups - To display the project in different colour/material combinations, the project must be divided

into groups of objects.

Variants - Each group can be saved with as many material combinations as required and later

combined to give variants (finished combinations for the whole project).
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12.5 Style - Presentation

This menu allows to change the type of the project presentation.

12.5.1 Style - Presentation - Inertia Mode

Use this option for demonstration purposes. It should be normally switched while working on your
model.

If Inertia mode is ON, when you rotate the last, the rotation will continue in real time until Inertia
mode is set to OFF, or you start a new rotation using the middle mouse button.

To control the speed of rotation either, adjust the speed you move the move the cursor faster or
slower before releasing the middle mouse button.

12.5.2 Style - Presentation - Exploded Mode

This lets you see an exploded mode view of your shoe.

Normal view

Exploded Mode view
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13 Workflow Overview

This menu allows to send and receive models for review.

13.1 Style - Send Style For Review

This option lets you export the current project to MindCAD 3D Viewer.

1. Select Send Style for Review from the Style menu

2. Enter the name for the exported project in the Save As dialogue box.

3. Select Save.

13.2 Style - Receive Style Review Feedback

Use this option to open annotation files.

Annotation files are created in Viewer. They contain instructions and comments made by Viewer

users.
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After loading the annotations file (.not file format), the Annotations toolbar appears on which the
operator can:

select the annotation to inspect by using the name combo box.

select the action to apply, either project annotation lines or accept annotation material changes.
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14 Window Overview

This menu lets you control the position and way your windows are arranged on the screen.

14.1 Window - New Window

This option opens another window.

14.2 Window - 1x1

This option closes all the other windows of the selected document, except one, that will be
maximized.
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14.3 Window - 2x2

This option show four windows of the selected document and organize them 2x2.

14.4 Window - List

Select the name of a current window to make it active.
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15 Applications Overview

This menu lets you switch to other MindCAD applications.

 

15.1 Applications - MindCAD Last Design & Engineering

This option lets you switch to the MindCAD Last Design & Engineering package.

MindCAD Last Design & Engineering lets you input or import lasts.

The lasts can then be edited and the surfaces flattened for use in MindCAD 3D Design &

Engineering.

15.2 Applications - MindCAD 2D Design & Engineering

This option lets you switch to the MindCAD 2D Design & Engineering package.

MindCAD 2D Design & Engineering lets you create your 2D patterns with allowances, notches,

text etc. They can then be graded and output to a cutter for production.



Part

XVI



476 MindCAD 3D Design & Engineering

© 2016 Mind - Software Multimedia e Industrial, SA

16 Help Overview

This menu lets you launch the help system, open the Mind web site and display the version number

of the current software.

 

16.1 Help - Help Topics

This option lets you launch the help system.

16.2 Help - Mind on the Web

This option lets you open the Mind website ( www.mindtech.com.pt ).
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16.3 Help - About MindCAD 3D Design & Engineering

This option displays a dialog containing the version number and licensing information.
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17 Libraries

The library system in MindCAD 3D Design & Engineering allows to open, create and delete library
folders. There are two main top level nodes for each library: 

the <default> is the folder where built-in elements delivered on installation of the software package
resides;
the <current model> where all the elements used by the current loaded project are accessible.
(The libraries Colors, Textures and Logos doesn't have this node)

Child of the node <default> are the user libraries, customized in an hierarchy controlled by the end
user. The operator is then able to organize library folders based on client, season, ... based on
personal or enterprise policies.

The libraries that provide this common base functionality are:
Accessories  
Stitches 
Punches 
Punch groups 
Materials 
Textures
Colors 
Stamps

17.1 Library - New

This option allows for the creation of library folders.

1. Click on the folder icon  in the left side of the libraries and the library manager window will
open.
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2. Right click on a node, for example the <default> node and some options appear. Select the New
Sub Library option.

3. Write the desired name and press Ok.

4. The new library folder is created.
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17.2 Library - Open

This option allows to open a library folder

In this example, using the Materials library, the <default> library folder is displayed by default

1. To open another folder simply click on the folder icon  in the left side of the libraries and the
library manager window will open.
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2. Select the Innocent library, in the right side is shown the materials on that library. Press Ok.

The displayed materials are now from the "Innocent" library folder.

17.3 Library - Delete

This option allows to delete a library folder.

1. Click on the folder icon  in the left side of the libraries and the library manager window will
open.
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2. Simply right click over a folder and select Delete

17.4 Library - Rename

This option allows to rename a library folder.

1. Click on the folder icon  in the left side of the libraries and the library manager window will
open.
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2. Simply right click over a folder and select Rename.

17.5 Library - Current model

This special system library <current model> always refers to library elements (materials,
accessories, stitches and others) used by the current loaded model.

Changing any of these elements by double clicking over it and changing its properties will reflect to
the visual properties of the design.
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This is just like another library in which you can open it to visualize its elements.

1. Click on the folder icon  in the left side of the libraries and the library manager window will
open.

 

2. Select the <current model> library. Only the materials used by this model are displayed.
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3. Click Ok. 

To see where determined material is used in the current model, do a right click over the material and
select the option "Select Owners".
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The places where the material is being used will highlight.

17.6 Library - Filtering and Sorting

Every library has filtering and sorting functionality. To access those, there are two button on the left
of each library. Each filtering and sorting is kept as private setting for each library.

This option allows to search a library folder. Just activate this button and write the name to search. 
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The search is always using an implicit wildcard matching algorithm that will be any element with "1"
in the name, no matter its position. The update of the underlying thumbnails is immediate.

This option allows to sort alphabetically. Press twice to cycle through ascending, descending and
no sorting modes.

On these buttons, there is a small square box on the right bottom side that indicates if the
functionality is enabled (green) or disabled (red).

17.7 Library - Pane Settings

To access the Pane Settings click on the icon   in the left side of the libraries and the library
manager window will open.

The follow window will appear.
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Size - To change the size of each item in the libraries
Min - Define the minim size 
Max - Define the maxim size
Scrollbar location minimize footprint - Enable/disable this option to change the scrollbar

location vertical/horizontal.
Spacing - The space between each item in the libraries

X - To change the space along the X axis
Y - To change the space along the Y axis

Border - To customize the border of each item in the libraries
Color - Allows to change the color of the border of each item in the libraries
Thickness - Allows to change the thickness of the border of each item in the libraries

Labels
Show Label - Enable/disable the label of each item in the libraries
style - To change the labels style

Font - Change the labels font
Color - Change the labels color

Show tooltip - Enable/disable the tooltips of each item in the libraries
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18 Colours, Materials, Stamps and Punches

18.1 Create Individual Colors

This dialogue box lets you mix single colors. It is accessed from several menus in the interface.

18.1.1 Selecting colors

Use the outer ring to select the color required.

Place the cursor in the circle within the ring, hold down the left mouse button and move it to the color
required. Releasing the mouse button to complete the operation.
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The new color will be displayed next to the old (original) color so you can see the changes.

Use the central square to select the shade of color; use the middle mouse button as before.

18.1.2 Using values to change colors

During the color selection process the values of the current color will also be displayed.

These values can be changed by using the up and down arrows next to the value or by entering a
new value in the relevant box.
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18.1.3 Adding the current colour to the custom colors

Select Add Custom button.

The color can then be used at any time during the current work session.

18.2 Edit Individual Colors

This dialogue box lets you mix single colors.
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18.2.1 Standard

This dialogue box lets you select single colors.

Its possible to use the mouse to select the new color. You just need to click over the new color to
see it in the preview window.

Or select the Select tool button to change the color, in this case you just need to move the mouse
over the colors to see it changing in the preview window.
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18.2.2 Custom

Its possible to use the mouse to select the new color. You just need to click over the new color to
see it in the preview window.
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Or select the Select tool button to change the color, in this case you just need to move the mouse
over the colors to see it changing in the preview window.

After selection the color, it's possible to change the intensity using the lateral bar
Click over the arrow and drag it up/down to add the desirer intensity to the selected color
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During the individual color selection in the Custom tab the values of the current color will also be
displayed.

These values can be changed by using the up and down arrows next to the value or by entering a
new value in the relevant box.

18.3 Colors Library

There is support to color libraries, hovering on top of an element will show detail about it. In this case
the RGB and HSV components.

Importing color sets defined elsewhere is possible using a CSV file with a specific structure.

18.3.1 Colors Library - New

This option allows for the creation of colors.

Do a right click over the colors library, the below menu will appear.

To create a new colocar select the option New... will launch the individual color dialog described in
Create Individual Colors.
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18.3.2 Colors Library - Edit

This option allows to edit colors. 

Do a right click over the required color, in the colors library. The below menu will appear.

Select the option Edit, it will launch the individual color dialog described in Edit Individual Colors.

18.3.3 Colors Library - Delete

This option allows to delete colors.

Do a right click over the required color, in the colors library. The below menu will appear.

Select Delete.
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18.3.4 Colors Library - Rename

This option allows the renaming of colors

Do a right click over the required color, in the colors library. The below menu will appear.

Select the option Rename.

18.3.5 Colors Library- Cut

This option is used to cut color into the color clipboard buffer.

Do a right click over the required color, in the colors library. The below menu will appear.

Select the option Cut.
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18.3.6 Colors Library - Copy

This option is used to copy color into the color clipboard buffer.

Do a right click over the required color, in the colors library. The below menu will appear.

Select the option Copy.

18.3.7 Colors Library - Paste

This option is used to paste the colors in the the color clipboard buffer (filled by cut or copy).

Do a right click over the required color, in the colors library. The below menu will appear.

Select the option Paste. This option will just be active if you have before copied or cut a color.
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18.3.8 Colors Library - Select All

This option is used to select all the colors in the colors library.

Do a right click over the colors library, the below menu will appear.

18.3.9 Colors Library - Import

With this option, import of multiple colors is possible from an CSV file (Comma Separated Values).

1. Choose the option Import.

2. Then select a CSV file. The format of this file should be as depicted below

3. The new colors will be imported into the current library.
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18.3.10 Colors Library - Export library

This option is used to export library colours for file (CSV format).

1. Select the Color Library to export;

2.On the right click menu select Export Library and choose the file in csv  format to be created.

The format of this export file is depicted below

18.4 Shaded Colors

To make shaded colors you need to mix individual colors.
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18.4.1 Mixing colors

Colours are mixed using the Materials Properties dialogue box. This dialogue box is accessed from

the Material library.

Ambient - Use the default value for normal use

Emission - Use the default value for normal use

Diffuse - Use this option to set the base colour. Click on the colour box for this option and use the

Colour Mixing dialogue box to change the colour.

Specular

 - Use this value to set the highlight colour. Click on the colour box for this options and use the

Colour Mixing dialogue box to change the colour. In most circumstances it is only necessary to

change the shade of the colour not the colour itself.
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 Shininess(%) and Transparency(%) - Use these options to

increase/decrease the shine and transparency of the colour. You can use the arrows to change the

value, or enter a value in the appropriate box.
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18.5 Materials

You can make a new material by combining a base shaded colour with:

a texture

a bump map

a reflection.

You can give the new material a name so that it can be applied to any item on the shoe.
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18.5.1 Adding a texture

Add a texture to your base color as follows:

1. Open the texture library. Second arrow in front of Diffuse option.

2. Select a Texture from the list and click ok

3. Select the required attributes.
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The base color shows through the texture. If you do not want to change the color of the original
texture use a monochrome base color.

18.5.2 Adding a bump map

Bump maps use the texture to give an embossing 3D effect to the material without making real
deformations to it. When wisely chosen could be a perfect alternative to time consuming and CPU
intensive operations like embossing.

Add a bump map to your base color as follows:

1. Open the texture library. The arrow in front of Bump Map option.
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2. Select a bump map from the list and click ok

3. Select the required attributes.
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4. when this material is applied extreme embossing effect can be seen.
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18.5.3 Adding a specular map

Specular maps use the texture to define different reflective properties to a certain material.

Add a specular map to your base color as follows:

1. Open the texture library. Second arrow in front of Specular option.
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2. Select a specular map from the list and click ok

3. Select the required attributes.
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4. when this material is applied localized chrome effect can be seen.
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18.5.4 Add a reflection

Add a reflection to your base color as follows:

1. Change the reflection percentage to achieve the required result.

18.5.5 Creating a transparent texture

While importing Texture as described in the File - Import - Texture topic, there is the possibility of
creating materials that emulates physical holes.

This could be controlled by using the original alpha channel contained by the image file (if supported)
or by creating a new one based on image properties. This allows for the creation of variable
translucent effects based on image properties.

For example, creation of an image with a net effect with blended opacity, from total to none, and
usage on a part, would result in the simulation of a part with tiny blended holes without having to
effectively drill those holes on geometry.

To create a transparent "drilled" texture do the following:

1. get a texture that is suitable to emulate holes, i.e. with enough contrast on the elements that will
define the boundaries of the "holes". Similar to the following texture.
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2. now check the Create transparency channel and select Based on intensity.

   

3. the image is analysed on its intensity and the drilled texture is displayed
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4. when the generated image is corrected then the Save button should be activated.

A material with a given Name and default parameters is generated on a chosen Material Library. 

18.6 Advanced Materials

The Advanced Materials are physically based, meaning that a user controls the look of a material by
manipulating physical parameters such as roughness, metallicity, age, and a plethora of other
physical parameters, each of which is defined on a per material base. These materials will also react
in a physically based fashion, i.e. they’ll reflect light as actual physical materials do, making them
photorealistic.
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18.6.1 Advanced Materials - New

Create a new advanced material.

1. Open the advanced material pane, right click and select new:

2. A file browser will appear, so that the user can select an image. Clicking Open will use the
currently selected image as the base for the advanced material:

3. The advanced material, is now available on the advanced material pane. 
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4. Do a right click over the advanced material and select Edit from the contextual menu or double
Click over it, and the Advanced Material Properties will open, a user can change any of its
parameters and visualize changes in real time.

Modifiable parameters for an advanced material created from an image are:
- Output Size: Controls the texture quality, 512, 1024 or 2048.
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- Metallic: Is the material more or less metallic? Metallicity controls the amount of light that a
material reflects. The more metallic a material is, the shinier it appears, since metal reflects more
light than organic material. 

- Normal intensity: Controls the perceived depth of any grooves or pits in the material.
- Roughness: Is the material more or less rough? When a material is rough, light is reflected from it

in a more diffuse way, since the material has a high number of microscopic grooves and pits. This
in turn means that a smoother material (low roughness value) will reflect light in a more uniform
manner and as a consequence will appear shinier. 

For example, a metal will have a high metallicity value. If the metal is rough (e.g. brushed aluminum)
its roughness value will be high and although the material will reflect a high amount of light, it’ll do so
in a more diffuse way. On the other hand, if the metal is smooth, its roughness will be low and the
metal will become much more reflective, since it reflects light in a much more consistent fashion.
Organic materials typically have a low metallicity value and as such don’t reflect as much light, as
well as a higher roughness, and as such the light that they do reflect will tend to be more diffuse.

Plastic materials typically have a low metallicity value (they reflect less light than metals), and also a
low roughness value (they’re smoother than organic materials).

18.6.2 Advanced Materials - Import

MindCAD3D allows to import Substances that can be created by a specialized designer, after being
published to an SBSAR file.  
When a Substance is imported into MindCAD 3D, MindCAD will allow a user to change all of that
Substance’s exposed parameters. 

To import an Advanced Material:

1. Open the advanced material pane, right click and select Import:

2. A file browser will appear, select one .sbsar file. Clicking Open and the Advanced Material will be
created. 
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3. The advanced material, is now available on the advanced material pane. 

4. Do a right click over the advanced material and select Edit from the contextual menu or double
Click over it, and the Advanced Material Properties will open, a user can change any of its
parameters and visualize changes in real time.
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18.7 Stamps

Stamps is a neat feature to be used when effects of badging, embossing and massive pattern

deformation is intended.

They could be applied to parts and sole surfaces.

A stamp should be previously prepared into a library item in order to be reused as many times as

possible.

Since embossing effects are time consuming and CPU intensive operations, the reconstructions of

parts and sole surfaces to reflect the actual deformation are done in low priority tasks to ensure user

interaction and flow is not affected. While those elements are reconstructed a special "under

construction" texture layer is applied to give feedback to the end user. 
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While this happens, a preview layer of the stamps, based solely on texture is applied.

18.7.1 Create Stamps

In order to use the stamp functionality, the operator should create a new stamp by importing a
combination of textures resources.

1. do a right click over the Stamps library and select New...

2. The following dialog will appear, in which the Name and at least a Height map or a Color map

should be configured to complete the stamp creation.
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3. the available options and operations are as follows:

Repeat stamp make a repetition pattern of the imported resource textures
Height Map - Clear clear the Height map component of the stamp. A stamp without a

height map will be equivalent to a thickless paint effect over a part.
Height Map - Read file select the file from which the height map will be extracted. It takes

the intensity channel from the image. Equivalent to transforming the
image to its greyscale counterpart.

Height Map - Copy from
colormap

use the resource defined as the Color map as Height map

Filter Use this option to filter the imported image, as you increase the
value the image get softer.

Black level height (mm) set the height value (mm) to be used on black pixels (after
conversion to greyscale). Should be less than White level height.

White level height (mm) set the height value (mm) to be used on white pixels (after
conversion to greyscale). Should be more than Black level height.

Color map - Clear clear the Color map component of the stamp. A Stamp without a
color map will be equivalent to an emboss effect without any kind of
painting effect.

Color map - Read file select the file from which the colour map will be extracted. There is
support for transparency enabling non squared stamps.

Color map - Copy from
heightmap

use the resource defined as the Height map as Colour map
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4. when making the following selections

5. the resulting logo after being applied to a part will look like this.

The stamp will be added to the library
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18.7.2 Applying Stamps

The interaction to apply stamps is very simple and intuitive. Logos could be applied over parts and
sole surfaces. 

1. just start a drag and drop interaction from the Stamps library toward the element to be affected.

2. press the left button over the logo, keeping it pressed while moving the mouse toward the drawing
canvas

3. release the left mouse button on the part or sole surface
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4. to edit the stamp position please use the stamp selection tool.

18.7.3 Stamps Properties

This option lets you adjust the logo quality.

1. With the stamp selection tool active do a right click over the logo and chose properties;

2. The message below appears
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Is possible to choose between Auto quality adjustment or Manual quality adjustment.

Auto quality adjustment - The quality of the stamp is calculated automatically.

Manual quality adjustment - Use the adjustment bar to set the desired quality. 

Displacement range (mm) - It's a map of heights based on the stamps colors.

Note: When are multiple stamps, the stamp with the highest quality requires the value of quality to

others in the part reconstruction.

18.7.4 Edit Stamps

To edit a placed stamp.

1. Click over the part that as the stamp applied do a right click and select Edit Stamp
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2.  The cursor will appear as  , now it's possible to drag, scale and rotate the stamp. And also
access it's properties.

18.8 Punches

18.8.1 Create Punch

To create a new punch.

1. Do a right click over the Punches library and select New...

2. The punch editor will open.
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3. Now draw the desired punch shape. 

4. You can draw a free punch  or a symmetric punch . 
4.1.Drawing a symmetric punch:

4.1.1.Select the symmetric punch  button from the punch editor tool bar.
4.1.2.Insert the number of axis and press ok.

4.1.3.The punch will appear in the work area.
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4.1.4.Now click and drag over the points to change the punch layout.

4.2.Drawing a free punch.

4.2.1.Select the draw a free punch   button from the punch editor tool bar.
4.2.2. Now apply as many points as desired. 

4.2.3.When finish, do a right click and select finish from the contextual menu.
5. When the punch edition is finished, select Save and Close from File menu, to save the changes. 
6. Now the new punch is available in the punches library. 
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